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Welcome

WELCOME TO
THE OFFICIAL
MAGAZINE
EGO is one of the most wonderful things
in the world. From the 1980s ‘What it is
is beautiful’ advert, to The LEGO Movie, it
has provided inspiration that spans generations.
LEGO was also the universally loved toy when
The MagPi team was young. It has been a constant
presence through our lives, regardless of our ages
or backgrounds.
I like to think there’s a lot that Raspberry Pi
and LEGO have in common, and the team’s been
hankering after making a LEGO feature for a while.
It’s not just childhood nostalgia – we feel it’s just
as useful for adults. The free-range creativity that
makes LEGO so much fun when you’re a kid is what
makes it useful as a digital maker. You can make
just about anything, given enough LEGO bricks.
Our LEGO and Raspberry Pi feature (page 16)
is spectacular. You will learn how to build LEGO
robots that solve Rubik’s Cubes, Segway-style
self-balancing robots, and retro NES games
consoles; and marvel at a huge bunch of incredible
community builds based on LEGO.
So don’t be afraid to add some LEGO to your
projects. It’s a versatile building material that
you can use, and reuse, across a range of builds.
Everything is awesome!
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News

FEATURE

RASPBIAN
STRETCHES OUT
Meet Stretch, and discover all the new features in Raspbian

he latest version of
Raspbian has been
released. Code-named
Stretch (named after the purple
octopus of Toy Story 3), there are a
few under-the-hood changes that
should simplify some aspects of
working with a Raspberry Pi.
Unlike last year’s Jessie update,
there’s not much visual change
between the previous version
(Jessie, the plucky cowgirl) and
Stretch. However, you don’t
have to dig too deep to find some
useful updates.
Multiple users are handled
better under Stretch. Raspberry
Pi Foundation UX Engineer

T

Simon Long explains that this is
“something we have done to make
life easier for schools and the like
[e.g. Code Clubs and CoderDojos],
which want to use multiple users
on a single Pi.”
“The Raspberry Pi Configuration
application no longer assumes
that it will always be run by the
‘pi’ user,” explains Simon. “If this
is used to enable automatic login,
it now sets it up for the current
user. If passwordless sudo has
been disabled for the current user,
applications which require sudo
will now prompt for a password
at start rather than just failing
to launch.”

Of Bluetooth
and databases

Bluetooth support in Stretch
is now handled by bluez-alsa
rather than PulseAudio. As
Simon clarifies, “the previous
approach using PulseAudio was a
bit clumsy, and necessitated my
taking control of PulseAudio and
starting and stopping it when
Bluetooth devices were selected
or removed.”
Stretch frees PulseAudio for
use in other projects (you’ll need
to install it first), while “the
change does also make things
tidier inside the code itself,”
according to Simon, who confirms

THONNY (SIMPLE MODE)
Thonny Python IDE has been
updated with a new Simple
Mode, available as a second app
(click Menu > Programming >
Thonny (Simple Mode).
Simple Mode strips Thonny
down to the bare essentials
required for starting with
Python. It removes the
configurable layout options in
favour of a fixed selection of
useful windows. The menus
have been removed and larger
captioned icons included. These
are more immediately visible,
and enable users to Save, Load,
Run/Stop and Debug scripts.
We expect Thonny (Simple
Mode) to be very useful for
Python training.
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NEW VERSION OF RASPBIAN
“there should be no significant
differences in [Bluetooth]
performance or quality.”
As Raspbian follows Debian’s
update schedule, MySQL has
been dropped in favour of
MariaDB (mariadb.com).
Simon explains that “we follow
Debian except in cases where
a) we have added a package
ourselves or b) we have fixed a
bug or changed functionality in a
Debian package. As this is neither
of those cases, we simply follow
Debian.” Simon also notes that,
as Debian drops PHP5 for PHP7,
so does Raspbian.

Download the latest version of Raspbian
from www.raspberrypi.org/downloads

Raspbian Stretch will ‘make life easier for
schools and the like, which want to use
multiple users on a single Pi’
If your build relies on MySQL
and you don’t fancy porting it
to MariaDB, you can still install
MySQL on Stretch.

Other updates

Raspbian Stretch ships with
Sonic Pi 3.0.1, which Simon says

“includes a lot of new functionality
in terms of input/output.”
Chromium has been updated to
version 60, which may run “slightly
faster than before” thanks to some
code optimisations.
Scratch 2 receives the Sense HAT
extension, allowing you to tinker

with the virtual Sense HAT as well
as the real thing. Look under More
Blocks and select Add an Extension.
It’s best to do a clean install
of Stretch (back up any data on
your Jessie-based system first)
by downloading the image from
magpi.cc/2eHd8M3.

RASPBIAN THROUGH THE AGES

WHEEZY

RASPBIAN JESSIE

ALL NEW DESKTOP

Before Raspbian, there was Debian, but
Raspbian was the ARM port of Debian to
run on the Raspberry Pi . Raspbian was
created by Mike Thompson and Peter
Green as an independent project. The
numerous tweaks and performance
improvements made Raspbian a highly
customised environment, eventually
becoming the offiically supported OS.

The first major overhaul of Raspbian
saw, in Simon Long’s words,
“modifications to the underlying system
to improve system processes” as well
as desktop interface updates, such
as booting to the desktop rather than
the command line. LibreOffice, Claws
Mail, and a GUI version of raspi-config
were added.

Just a year later, Jessie saw a massive
update to its visual desktop interface.
With gorgeous background images
and a modern treatment for icons,
menus, window frames, and scrollbars,
Raspbian with the Pi Desktop is every
bit as slick as operating systems
running on hardware a hundred times
more expensive.

July 2012
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INTELLIGENT MUSEUMS

INTELLIGENT

MUSEUMS
A bespoke experience for every visitor

hrewsbury Museum
& Art Gallery
(magpi.cc/2vIdFEB)
hosted a week-long hack, allowing
Microsoft and consultancy firm
Black Radley (blackradley.com)
to create an intelligent exhibit.
While many museums use
multimedia elements for certain
exhibits, these videos or talks are
the same, whether a child or a
70-year-old activates them. The
hack team wanted to do better.
The aim was to make a system
that would serve content suited to
the demographic and engagement
of the visitor.

S

Open source

Integral to the brief was that the
project should use open-source
software and hardware costing
less than £100, so an old webcam
and speaker were hooked up to a

Raspberry Pi 3. The Pi used a UWP
(Universal Windows Platform)
on Windows IoT Core to access
facial recognition algorithms via
Microsoft’s Cognitive Services
Face API.
Black Radley’s Joe Collins
explains that “using a webcam
gives us a bit of flexibility because

Keeping the project open-source
allows the museums to adapt the
device to their own needs
they often come with quite
a long cable.”
Hack collaborator and Microsoft
Technology Evangelist Martin
Kearn adds that the use of
Windows IoT Core “enables us
to support almost any webcam
that is supported on Windows,
on any device.”
Left In true hacker style, this was the
plan for the device

8
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Above The device uses a webcam that was
“languishing in the back of the cupboard”

Joe explains that the Pi 3 was
used because “it is handy to have
the USB sockets for the webcam
and to power the speakers.”
You could use the project code
(magpi.cc/2gCYfqQ) on a Pi
Zero W, or as Martin points out,
on “laptops, desktops, tablets,
phones, Xbox, 80-inch Surface
Hubs”, or anything that can run
Windows 10.
It was important to the hack
team that the project was opensource because, as Joe tells us,
“there are a lot of museums out
there […]. Keeping the project
open-source allows the museums
to adapt the device to their
own needs.”
Martin adds that “Microsoft
is a big advocate of open-source
technologies […]. When we
engage in ‘code with’ activities
with customers and partners, we
always like the project itself to be
open-source.”
raspberrypi.org/magpi
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FEATUREAIY VOICE KITS ON SALE
GOOGLE

AIY PROJECTS

VOICE KITS
PRE-ORDER
Pre-order your Google AIY Projects Voice Kit

ollowing overwhelming
popularity of the free
Google AIY Voice Kits
we offered with issue 57, the
kits are being made and sold
as standalone products.
You can pre-order kits
in the UK from The Pi Hut
(magpi.cc/2hkKbCI) and
Pimoroni (pimoroni.com/aiy)
for £25, or in the US from Micro
Center (magpi.cc/2heOVxa).

F

Above The new AIY kit
comes with a 76-page The
MagPi Essentials book to
guide you from cardboard
to complete build
Below The new kit is easier
to build, with “a vastly
improved API” to make
projects easier to create

As long as there is
demand, we plan to
keep making them
The new kits are easier to
assemble than the initial freebies,
with “a vastly improved API that
makes it a lot easier to program”
according to our own Editor,
Lucy Hattersley.
The kit will also come with a
76‑page The MagPi Essentials book
to get you started. As Lucy puts it:
“The new AIY Projects Essentials
book is a brilliant introduction to
voice recognition technology using
Google Assistant SDK and Google
Speech APIs.”
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The kits are made and
distributed by US retailer Micro
Center (www.microcenter.com),
as merchandise manager
Samantha Snyder explains:
“Originally, we approached
Google with a large order of kits
to give away to our customers
who purchase a Raspberry Pi 3,
after the massive demand for
The MagPi kit.”
“We immediately volunteered
to handle manufacturing and
logistics,” she adds.

Sold out?

You shouldn’t have to worry
about the kits selling out: “as
long as there is demand, we plan
to keep making them,” confirms
Samantha. Micro Center has
“been tracking their demand
closely to ensure they will stay
in stock,” she tells us.
Pimoroni director Jon
Williamson agrees: “Initial unit
count shouldn’t be an issue … we
expect to be able to get hold of as
many as needed, within reason.”
Samantha also confirms that
“We plan to work with Google and
the Raspberry Pi Foundation to
provide feedback on the kits.” The
future of AIY Projects is bright.

raspberrypi.org/magpi

PI 3 MAKES ‘ULTIMATE EDUCATION LIST’

PI 3 MAKES
‘ULTIMATE
EDUCATION
LIST’
As essential as a multimeter or microscope
he Raspberry Pi 3 has
made Farnell element14’s
ultimate education list,
making a Pi 3 as indispensable
to the engineer as a multimeter,
oscilloscope or 3D printer.
Farnell element14 is a major
Europe-wide distributor of
electronics, technology and

T

Global head of PR and External
Communication, Holly Smart,
explains why the Pi 3 was chosen:
“We believe the Pi 3 has one
of the best SBC [single-board
computer] propositions on the
market: compatibility, community
support, ecosystem, software,
and tutorials; combined with

We believe the Pi 3 has one
of the best SBC propositions
on the market
electronic system designs, and
maintenance and repair services.
Farnell element14’s Business
President for Sales and Marketing
Europe, Peter Birks, says of the
list, “Supporting the education of
engineers is vital to ensure that the
next generation has the talent to
drive our industry forward.”

the performance-to-price ratio,
that’s fantastic.”
Farnell directly helps in
the training of engineers too,
as Holly tells us: “Farnell
staff regularly support local
schools and universities with
coding clubs, science fairs,
and general electronics.”

News

NOW TRENDING
The stories we shared
that flew around the world

RASPBERRY PI DESKTOP X86
magpi.cc/2wkkThL
Now you can use Raspbian on your laptop or desktop
PC. Just download the image from rpf.io/x86 (or use
the DVD mounted on the front of issue 60) and install
it to a USB drive using Etcher (etcher.io). Boot from the
USB drive to replace Windows or macOS with a fast,
modern, and secure alternative.

RUN WINDOWS AND OTHER X86
SOFTWARE ON YOUR PI
magpi.cc/2wgLo7N
The Eltechs ExaGear Desktop allows you to run any
software on a Raspberry Pi, whether that’s Windows
games, standard x86 Linux software, Microsoft Office
or even a browser that will display Netflix video. In our
review, we concluded, ‘ExaGear is worth its lifetime
price if you need a specific piece of x86 software.’

Below The Pi 3 is as essential and useful as this £5,500 Keysight N6705C Power Analyser

10 MILLION WELSH PIS MADE
magpi.cc/2vTqSG4
The Sony UK TEC manufacturing plant in Pencoed,
South Wales, was originally contracted to make 10,000
Raspberry Pis. Five years later, the factory has just
produced its ten millionth. In fact, one million Raspberry
Pi boards were made in the first year alone – quite the
achievement considering that tentative first order.
raspberrypi.org/magpi
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PI POWER SWITCH / ANDROID THINGS

REMOTE-CONTROLLED

PI POWER SWITCH
Hackable board adds sofa-based power control
resh from Kickstarter
success, the Nanomesher
Hackable Switch has
hit the shelves. The device sits
between the power supply and
the Pi’s power input, essentially
adding a remote-controlled power
switch to the Pi.
The ‘hackable’ trick with the
device is its socket-mounted
ATtiny85 Arduino Development
MCU. Lift this chip from its seat,
plug it into a breadboard, and you
can reprogram it to behave as
you like.
Nanomesher provides a guide to
reprogramming the teeny ATtiny
chip: magpi.cc/2wDfrnz.
Tech tester and ModMyPi CEO
Jacob Marsh wanted to stock the

Left and below An IR,
remote-controlled
power switch with
hackability

F

device because it’s a “very nice
power switch, with some added
hackability features. What’s not to
like? We especially liked the fact
that it comes pre-assembled with
an IR remote, all ready to rock.”
Alas, the IR input of the
hackable power switch means
it’s incompatible with the (RF)
OSMC Remote Control. The
hackable power switch is available
now from ModMyPi for £22
(magpi.cc/2eHjqeA).

ANDROID THINGS

ENHANCES PI SUPPORT
New Pi-specific features for better IoT devices
oogle has added a few
Pi-specific updates to the
latest build of its Internet
of Things OS, Android Things.

G

Developer Advocate for IoT,
Wayne Piekarski, points to two
major updates in Android Things
DP5: OpenGL ES 2.0 support and
WebView. Both of these features
were “highly requested features
from developers,” according
to Wayne.

Flexible connections

Above The latest IoT OS from Google includes some
“highly requested features” for Pi support
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OpenGL ES 2.0 is a graphical
API for 2D and 3D graphics, so
we can expect more visually
impressive Pi-based Android
Things interfaces. WebView allows
the opposite: it’s an API to show

web-like content (basic HTML,
for example) without the extras.
JavaScript, HTML5 video and so
on can be ‘injected’ back into the
page, as detailed in the WebView
manual (magpi.cc/2wCCqki). As
such, WebView might prove to be a
handy way to connect with an IoT
device as quickly and responsively
as possible.
Finally, Android Things DP5
adds dynamic pin muxing
for the Pi 3, “with pins being
configured at runtime depending
on what features are being used,”
Wayne clarifies.
raspberrypi.org/magpi

ASTRO PI

ASTRO PI IS
GOING BACK

TO SPACE
ISS upgrade will add WiFi dongles
to Astro Pi units

The Atlas V rocket. Image credit:
NASA/United Launch Alliance

he Astro Pi team is putting
together a new payload to
upgrade the two Raspberry
Pi units on board the International
Space Station.
The upgrade, due to launch in
January 2018, will provide two USB
WiFi dongles, five optical filters,
and four 32GB microSD cards for
the two Astro Pi units, nicknamed
‘Ed’ and ‘Izzy’.
Alongside the new launch comes
a new set of missions for students.
Astro Pi is searching for the next
generation of space scientists, and
wants to inspire as many students
as possible to take part in space
science with code.
This year, there are two
different missions for students
to enter (see ‘Astro Pi Missions’
box). After registering for the
missions, students will work like

T

News

real scientists to design their own
programs and experiments.
“We’re preparing young people
for the jobs of the future,” says
Dave Honess, Astro Pi Programme
Manager. “We want to show
the possibilities of computer
programming as a digital skill,
and encourage young people of
school age towards further study
of STEM subjects and associated
careers – Astro Pi being especially
relevant to the aerospace industry,
which will see huge growth over the
next 20 years. Astro Pi gives each
student the opportunity to be an
active participant in space science,
rather than just an observer.
Having a creation of theirs reach
space and do something there is
profoundly cool.”
Student teams can register for
the missions at astro-pi.org.

ASTRO PI MISSIONS
This year, there are two missions available for Astro Pi.
Teams must enter by the deadline, but the competition
then runs into 2018 alongside the mission launch.

MISSION SPACE LAB
magpi.cc/2xikb54
Registration closes: 29 October 2017
• A scientific mission for young people
no older than 19
• Design an experiment, receive free computer
hardware to work with, and write the Python code
to carry it out
• Your code could be uploaded to the International
Space Station and run for three hours (two orbits)
• Get your results back from space and analyse
them like a real space scientist
• The ten best final reports will win special mentions
and exclusive space-related prizes

MISSION ZERO
magpi.cc/2fkznHZ
Participation closes: 29 November 2017
• A non-competitive mission for young people
no older than 14
• Write a simple Python program using free
online tools
• P
 rovided you adhere to a few rules, your code
is guaranteed to run in space for 30 seconds
• R
 eceive a certificate showing the exact time
when your code was running on the ISS

raspberrypi.org/magpi
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BUILDERS AND MAKERS UNITE
TO CREATE AWESOME
PI-POWERED LEGO PROJECTS

EGO has always inspired people. While it is
undeniably satisfying to build a set like the
UCS Millennium Falcon, there is nothing as
inspiring and creative as a child with a box of LEGO
pieces. LEGO has the potential to become anything:
a moon base with rockets and laser cannons, a pirate
ship, a castle, or a city.
It’s this imagination and improvisational spirit
that’s stayed with us as makers, so it’s only
appropriate that makers often turn to LEGO to bring
life to their ideas. Grab some LEGO and a Raspberry Pi,
and let’s build something amazing!

L

16
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MAKING WITH LEGO

Recommended

PURCHASES

WANT TO MAKE SOME AWESOME LEGO PI BUILDS?
HERE’S THE INSIDE INFORMATION YOU NEED…
LEGO PICK A BRICK

£3/$3

Buy individual LEGO bricks

magpi.cc/2wOdXIS
Need some specific LEGO pieces? There are nearly 1,500
individual parts to choose from on the LEGO Pick A Brick
website, and prices start at a few pennies. A similar
service can be found in bricks-and-mortar LEGO stores.
It’s a bit too easy to lose an hour of your life on here
though, so be careful.

Price
Varies

LEGO
MINDSTORMS
EV3
LEGO robotics kit
magpi.cc/2xhMlgX
The EV3 is the starter kit
for MINDSTORMS robotics
projects. Combine the pieces
in different ways to make
your own amazing robots.
It has been used with the
BrickPi to make wonderful
creations in the past, and is
used in some of the projects
on the following pages.

BRICKPI

Connect LEGO MINDSTORMS robotics
to your Raspberry Pi
magpi.cc/2weNxwt
Dexter Industries’ BrickPi is an amazing piece of kit.
It interacts with the popular LEGO MINDSTORMS kits
to create robotic beasts, controlled via a Raspberry Pi.
Several projects in this feature use BrickPi.

MICRO MOTOR
LEGO ADAPTOR

From
$99/£75

magpi.cc/2weTAkF
Want to use LEGO for the
chassis of your creation?
For robots and other moving
objects, that can be tricky.
This adaptor allows you to
use micro metal gearmotors
(magpi.cc/2eYKHZR)
with LEGO axles to
create supercharged
LEGO machines.

£300
/$350

LEGO wheel adaptor
for motors

LEGO DIGITAL DESIGNER
LEGO designer

magpi.cc/2wNPp2R
Want to see whether your design is feasible? Boot
up Digital Designer and virtually build your next
LEGO project. You can also use it to make handy,
step-by-step instructions for your project.

raspberrypi.org/magpi
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BRICKUBER

BUILD A RUBIK’S CUBE-SOLVING ROBOT
USING THE RASPBERRY PI AND LEGO
PARTS LIST
BrickPi3 Base Kit
magpi.cc/2wyukZX

LEGO MINDSTORMS EV3
magpi.cc/2xhMlgX

Dexter Industries
Power Battery Pack
magpi.cc/2xb7IzG

Rubik’s Cube
magpi.cc/2xRaTcL

8 × AA batteries
The BrickPi3,
with motor and
sensor cable
connections

he Rubik’s Cube has
recently begun to make a
comeback. Solving it takes
thought, effort, and skill – so why
not let a robot do it? In this project,
we take a Raspberry Pi, a BrickPi,
and a LEGO MINDSTORMS set, and
build a Rubik’s Cube-solving robot.
Simply place an unsolved Rubik’s
Cube in the solver, run the Python
program, and your Rubik’s Cube
will be solved! The BrickPi3 takes
the unsolved Rubik’s Cube, while
the Raspberry Pi takes a picture
of each side of the cube using the
Camera Module. This image is then
used to solve the fiendish puzzle.

T

The shuffler
arm shuffles the
Rubik’s Cube,
rotating the cube
on the y-axis

JOHN COLE &
MATTHEW A.
RICHARDSON
Two robot engineers with Dexter
Industries. Matt builds robots in
Michigan and John builds robots
in Dubai. Both enjoy sand dunes,
mountains, and playing with LEGO.
dexterindustries.com

CODE
Filename: BricKuber.py
Language: Python
magpi.cc/2vYZPsT

>STEP-01

Building the solver
This design was inspired by the
MindCub3r design for LEGO EV3.
To build the BricKuber, start by
building the MindCub3r using the
instructions at mindcuber.com. The
design features three major moving
parts: a cradle to hold the Rubik’s
Cube; a shuffler arm that is used to
turn the Rubik’s Cube over; and a
camera arm that holds a Raspberry
Pi Camera Module over the Rubik’s
Cube. Two LEGO MINDSTORMS
motors manipulate the Cube on
the horizontal and vertical axes.

Three different
motors are used
to manipulate
and read the
Rubik’s Cube

18
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MAKING WITH LEGO
>STEP-02

Assemble the BrickPi3
Assemble the case and attach the
BrickPi3, the Raspberry Pi, the
Raspberry Pi Camera Module, and
the battery pack. You can find
assembly instructions for the
BrickPi3 at magpi.cc/2w30wBe.
Raspbian for Robots comes with
most of the software you need
already set up. We recommend
using an 8GB SD card.

>STEP-03

Attach the BrickPi3
Now add the BrickPi3 to the
LEGO assembly. Use the LEGO
EV3 ‘wings’ to support the
BrickPi3 level with the BricKuber
body. Add batteries to the power
pack and attach it to the LEGO
assembly. While programming,
you can power the BrickPi3 via
USB power to the Raspberry Pi.
To move the motors, you will
need to supply power with the
Power Pack.

>STEP-04

Connect the motors
to the BrickPi3
Attach the shuffler motor to
motor port MD. Attach the
cradle motor to the MA port on
the BrickPi3. Attach the Camera
Module motor to the MC port

(this is the smaller, servo-like
motor). The camera doesn’t
move while solving the Cube,
but you may want to adjust
its initial location using
the motors.

The Camera
Module reads the
different colours
on the Cube, and
sends the data
to the BrickPi3 to
be mapped

>STEP-05

Attach the
Raspberry Pi
Camera Module
Using the LEGO camera
support, attach the Camera
Module. The small black lens
should fit between the two
LEGO beam supports. Secure
the Camera Module to the LEGO
supports using electrical tape.
Make sure that the camera is in
the correct position to capture
the entire Rubik’s Cube. You
can take a test picture with the
raspistill command: raspistill

-o cam.jpg. Make sure the
Cube is centred in the middle
of the image.

>STEP-06

Prep the software
You can use any version of
Raspbian, or Raspbian for
Robots (the custom image that
comes with the BrickPi3 already
installed). If you are using
Raspbian, you can install the
BrickPi3 libraries:
The BricKuber
with a solved
Rubik’s Cube

sudo curl https://raw.
githubusercontent.com/
DexterInd/Raspbian_For_
Robots/master/upd_script/
fetch_brickpi3.sh | bash
This step will install all the
libraries you need to run the
BrickPi3 on Raspbian. Finally,
install all project dependencies:

sudo curl https://raw.
githubusercontent.com/
DexterInd/BrickPi3/master/
Projects/BricKuber/install_
brickuber.sh | bash

>STEP-07

Solve a Rubik’s Cube
Place an unsolved Rubik’s Cube
in the cradle. Use the command:

sudo python ~/Dexter/
BrickPi3/Projects/
BricKuber/BricKuber.py
The robot will turn the Cube to
each face, and the camera will
take six pictures – one of each
side of the Cube. The Raspberry Pi
will use the pictures to determine
the Cube’s configuration. The
Cube configuration will be passed
to the kociemba Python library to
find an efficient solution. Finally,
the robot will execute the moves
to solve the Rubik’s Cube!
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BrickPi
BALANCEBOT

TWO WHEELS GOOD, FOUR WHEELS BAD:
BUILD A BALANCING ROBOT WITH A RASPBERRY PI
PARTS LIST
BrickPi3 Base Kit
magpi.cc/2wyukZX

LEGO MINDSTORMS EV3
magpi.cc/2xhMlgX

Dexter Industries
Power Battery Pack
magpi.cc/2xb7IzG

8 × AA batteries

re you tired of robots with three or more
wheels? We have a solution! Using a pile
of LEGO and a Raspberry Pi, you can have a
robot wheeling around on two wheels in minutes. Our
project uses the BrickPi3, which uses precise motor
controls to create a robot that balances on two wheels.
The project uses the LEGO gyroscope to detect whether
the robot is falling over, and a Python program on
the Raspberry Pi to control the motors with a PID
(proportional-integral-derivative) algorithm.
To get going, simply build the robot, install the
program, and run!

A

JOHN COLE &
MATTHEW A.
RICHARDSON
Two robot engineers with Dexter
Industries. Matt builds robots in
Michigan and John builds robots
in Dubai. Both enjoy sand dunes,
mountains, and playing with LEGO.
dexterindustries.com

The BrickPi3
and Raspberry Pi
are the brains of
the robot

The LEGO
motors provide
the power to the
robot’s wheels

The LEGO
gyroscope sends
data to the
Raspberry Pi to
keep the robot
balanced
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CODE
Filename: BalanceBot.py
Language: Python
magpi.cc/2vZHrQr

>STEP-01

Assemble the BrickPi3
and the Raspberry Pi
First, assemble the case, the
BrickPi3, and the Raspberry
Pi. You can find assembly
instructions for the BrickPi3
at magpi.cc/2w30wBe. We
recommend using Raspbian for
Robots, a version of Raspbian
that comes with the BrickPi3
software already installed. You
can also use your own version
of Raspbian, and run our install
script (magpi.cc/2gOjPbT) to
create the BrickPi3 setup. For
this project you will also need
eight AA batteries.

>STEP-02

Build the BalanceBot
This robot design is very
simple and only uses parts that
come with the MINDSTORMS
kit. You can find detailed
instructions, in LEGO Digital
Designer format, and in HTML,
on GitHub: magpi.cc/2vZHrQr.
You will need two EV3 motors
(with the red hubs and grey
bodies). Check that the IR
controller that came with the
LEGO kit is working, and that
the batteries are fully charged.
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>STEP-03

The BrickPi3 is
attached to the
robot’s body
using black
LEGO pins

Attach the BrickPi3
Add the BrickPi3 to the LEGO
assembly. The acrylic body is
attached using the black LEGO
pins that come with the LEGO
kit. Place the pins into the
body of the BrickPi3 first, then
attach the BrickPi3 to the LEGO
BalanceBot. Place the batteries
inside the battery box, and
connect that to the BrickPi3.

>STEP-04

Connect the motors
and sensors to the
BrickPi3
The left and right motors are
connected to ports MA and MD
on the BrickPi3. You can find
the port labels etched next to
the ports on the BrickPi3 case.
The cables should not cross each
other. Choose a set of wheels to
attach to the motors. The code
that comes with the project is
designed to work with the black
low-profile racing wheels that
come with the LEGO kit, but
you can adjust the variables in
the Python program to fit any
compatible wheel set.

>STEP-05

Connect the sensors
to the BrickPi3
This project uses the LEGO
infrared sensor and the LEGO
gyroscope. The gyroscope will
read the rate at which the

BalanceBot is falling over, and
adjust the motors. This sensor
is connected to BrickPi3 sensor
port 4. This project uses the EV3
infrared sensor to receive control
commands: use the infrared
beacon to command the robot
to roll forward, backward, and
turn. The EV3 infrared sensor
is attached to BrickPi3 sensor
port 1. Be sure to set the infrared
channel on the EV3 infrared
beacon to channel 1.

>STEP-06

Prepare the software
You can use any version of
Raspbian, or Raspbian for
Robots (the custom image that
comes with the BrickPi3 already
installed). If you are using
Raspbian, you can install the
BrickPi3 libraries:

sudo curl https://raw.
githubusercontent.com/
DexterInd/Raspbian_For_
Robots/master/upd_script/
fetch_brickpi3.sh | bash
This will install all the libraries
you need to run the BrickPi3
on Raspbian.

>STEP-07

Run the program
Power up your BrickPi3 and
connect it to your Raspberry Pi.
In the command line, enter:

sudo python ~/Dexter/
BrickPi3/Projects/
BalanceBot/BalanceBot.py
After starting the program,
you will be prompted to set
the robot upright. Balance the
BalanceBot as well as you can,
standing upright, and almost
balancing on its own. In the
Terminal, you will be prompted
to press a button on the IR
remote control to start the
balancing process. When you
press the button, your robot
should begin to balance on two
wheels on its own!
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Build A RETRO
CONSOLE CASE

DON’T LIKE THE IDEA OF 3D-PRINTING A CASE?
HERE’S HOW TO MAKE A LEGO CASE!
PARTS LIST
LEGO
magpi.cc/nespilego

RetroPie
retropie.org.uk

USB game controller

ant to make a retro
console with your
Raspberry Pi? There are
several tutorials online, but many
of them use 3D-printed cases.
Building with LEGO is much
more fun than watching a 3D
printer whirr away, so here’s how
to make a NES-like Pi case out
of LEGO.

W

>STEP-01

>STEP-03

>STEP-05

>STEP-02

>STEP-04

>STEP-06
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>STEP-07

>STEP-11

>STEP-08

>STEP-12

>STEP-09

>STEP-13

>STEP-10

>STEP-14
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Feature
>STEP-15

>STEP-19

>STEP-23

>STEP-16

>STEP-20

>STEP-24

>STEP-17

>STEP-21

>STEP-25

>STEP-18

>STEP-22

>STEP-26
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>STEP-27

>STEP-31

>STEP-28

>STEP-32

>STEP-29

SETTING UP
RETROPIE

Feature

We’ve covered setting up RetroPie in the
magazine before, most recently in issue
55’s PiGRRL Big Build (magpi.cc/2fczrWL).
The process is extremely easy, and
RetroPie guides you through the setup
step by step once you’ve installed
it on an SD card.

>STEP-30
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Inspiring

LEGO PROJECTS

INCREDIBLE PROJECTS AND IDEAS
FROM THE RASPBERRY PI COMMUNITY

e love seeing your amazing LEGO projects.
Young or old, it’s a great way to really fire
up your imagination and make something
amazing. Here are some of our favourite builds from
around the globe – we hope they inspire you to make
something spectacular!

W

INTERNET

OF LEGO
URL

The streets are
very detailed,
with Minifigures
going about their
awesome lives

internetoflego.com

MAKER
Cory Guynn
We’ve featured the Internet of
LEGO in The MagPi before, but we
always think it’s worth revisiting.
It’s an incredible, ongoing project
that creator Cory Guynn uses to
teach himself IoT by developing
a working LEGO city.
A Raspberry Pi controls the
city, aided by microcontrollers
and other Pis hidden in the
different structures.
“I grew up playing with LEGO
bricks and model trains,” Cory
told us, “which taught me about
construction and electronics,
and allowed me to be creative.
The use of LEGO also allows
me to represent a city or build
prototype systems easily.
Plus, it gives me an excuse to
buy a bunch of LEGO bricks in
my thirties.”
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LEGO
ARCADE
MACHINE
URL

MAKER

magpi.cc/2wbUpuz

Tobias Hübner

Tobias Hübner loves to combine
LEGO and Raspberry Pi. He’s made
many cases out of LEGO, based
on or using official LEGO kits
that he’s modified for purpose.
With some projects, he goes a
little further.
While it works as a case for
the Raspberry Pi, this arcade

machine also has buttons and a
display built into the model, so
that works as a proper tabletop
arcade machine! It’s a one-player
device, and Tobias describes it as a
LEGO Game Boy. You can find out
how it fits into the Raspberry Pi
computer lab at Tobias’s school on
his website: magpi.cc/2wKsepX.

The finished
project is
lovely and very
eye-catching

LEGO
SORTING
ROBOT
URL
magpi.cc/2wbmDpb

MAKER
David Pride
Playing with LEGO is fun, but
what do you do when you need to
clear up afterwards? Either you
chuck all the pieces into a box, or
you build a LEGO robot to sort the
bricks and tidy them away neatly.
David Pride opted for the
latter, and his robot uses LEGO,
a Raspberry Pi, and a MeArm to
sort individual LEGO bricks by
colour. It works by feeding LEGO
bricks down a chute, where the
Raspberry Pi then takes a photo

raspberrypi.org/magpi

of the brick. It determines what
colour the brick is, then the
MeArm robot arm swings around,
picks it up, and puts it in the
correct container.
Of course, the time it took to
build and program the arm could
have been used to put the LEGO
away to begin with.

SEND US YOUR
PROJECTS!
Have you made a LEGO Raspberry Pi project? Has this
feature inspired you to create something incredible?
Send photos to us on Twitter (@TheMagP1) or via email
(magpi@raspberrypi.org) – we’d love to see it!
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WALL-E
URL
magpi.cc/2wKb3oE

MAKER
Tobias Hübner
The LEGO WALL-E kit is lovely –
the simple, mechanical design of
WALL-E lends itself to translation
into blocky LEGO. However,
WALL-E is a robot, and this kit
doesn’t include any robotics –
so Tobias added some.
This WALL-E build uses a
PicoBorg Reverse (magpi.cc/
2wUzmk1) and motors to move
it around, and it’s all controlled
via a Wii Remote and a Bluetooth
dongle on the Raspberry Pi. The
best part is that because the
WALL-E kit has a cavity in the
centre, you can store most of the
electronics inside him! Bonus.

The Raspberry
Pi is hidden
away inside
WALL-E

RFID MINECRAFT
URL
magpi.cc/2wdVdPu

MAKER
Spencer Organ
Using a physical LEGO Minecraft
build, you scan RFID cards to send
signals to a Raspberry Pi, which
then builds a specific object in
Minecraft. This project is a beautiful
melding of physical and virtual
worlds, which is something we love.
It was built for Raspberry Pi’s
fourth birthday party, and Spencer
describes it as a demo of how
children with limited motor skills
can still play Minecraft. The cards
allow you to build a house, create
a waterfall, create a lava version of
the waterfall, and play a mini game
involving TNT.
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LEGO LASER
URL

MAKER

magpi.cc/2wNyiOP

Elijah Horland

There’s a clichéd joke in TV
shows about smart people.
As a child, any smart character
will have built something
unbelievably advanced for
a school science fair.
Elijah is a smart schoolchild
who is currently living this
fantasy. For his science fair,
he created a LEGO laser gun.
More accurately, it’s a maser,

which uses microwaves instead
of light, but it is still powerful
enough to burn patterns into
wooden boards. He was awarded
full marks, and the rest of the
kids voted it as their favourite
project. We wonder whether this
was due to the high quality of
the build, or the fact that Elijah
is now armed with a working
laser gun...

BRICKPI BOOKREADER 2
URL
magpi.cc/2welg9o

The ingenious
solution to
turning the page:
use a wheel

MAKER
Dexter Industries
Earlier this year, the great
folks at Dexter Industries
(who made the Rubik’s
Cube solver on page 18 and
the BalanceBot on page 20)
created a Pi-powered LEGO
robot that could read a
Kindle. It uses the Pi Camera
Module to take a picture, and
then uses text-to-speech to
read the text aloud before
swiping across the screen
to turn the page.
While that was cool, what’s
even cooler is to build a robot
that works with a real book,
and so the Bookreader 2
was created. It uses a wheel
to turn the page, takes a
picture, and reads it to you.
We wonder if any young kids
would like a robot to read
them a bedtime story while
we watch Black Sails...
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HOME ALONE

HOUSE
URL

MAKER

magpi.cc/2wNikE5

Christopher Hill

This isn’t a house full of traps
to slow down a set of Minifigure
burglars, however cool it might be
to wallop one with a LEGO brick
on a piece of string. Instead, this
house is a recreation of the scene
where Kevin manages to create
the illusion of a party in his house
through an elaborate, Heath
Robinson setup.

The project
uses sensors to
trigger the actions
of automated
party-goers in an
elaborate LEGO setup.
We love the reference and
the ingenuity behind making
it in LEGO, so we feel it definitely
deserves a place here!
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SUBSCRIBE
Tutorial WALKTHROUGH TODAY AND RECEIVE A

FREE
PI ZERO W

Subscribe in print for 12
months today and receive:
A free Pi Zero W (the latest model)
Free Pi Zero W case with three covers
Free Camera Module connector
Free USB and HDMI converter cables

L
OFFRIOCCIA
ASE
PI ZE

WITH 3

COVERS

AND FREE CAMERA MODULE
CONNECTOR AND USB / HDMI
CONVERTER CABLES

Other benefits:
Save up to 25% on the price
Free delivery to your door
Exclusive Pi offers and discounts
Get every issue first (before stores)
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ABHISHEK SINGH
When he’s not heading up the
design of the 360o live streaming
video platform Svrround, Abhishek
is making things.
magpi.cc/2xuzCHP

A Raspberry Pi 3 is connected to an
Adafruit PiTFT screen on the back of the
camera – Abhishek dubs this the CamPi

The cartridge (aka SnapPi) slots into
the CamPi, and shows the resulting GIF.
Each new GIF replaces the previous file

An ad hoc wireless network is
created on bootup, which allows
the two Pis to communicate
without an internet connection

Quick
Facts
> The Instagif
is inspired by
the Polaroid
OneStep SX-70
> A Pi 3 and
Pi Zero W
are used
> Instagif takes
three-second
GIFs
> The GIF fades
into view like a
Polaroid image
> It took four
weeks to
design
and build

INSTAGIF
NEXTSTEP
Ever wished your instant camera could cope with moving images?
Abhishek Singh has the answer!

efore digital cameras
became popular,
photographers would use
film to capture their images. They’d
take a set number of shots and send
their snaps away to be processed,
but then they’d have to wait days –
or even weeks – to see the results.

B

Instant cameras were invented
to speed up this process. Polaroid
became famous for making
cameras that could print out a
paper-based photo in seconds.
A few shakes, and the image
would appear as if by magic.
While instant cameras have fallen
out of favour with the advent of
digital cameras, the appeal of the
concept endures.

Instant update
Right The
cartridge looks
like a Polaroid
picture, and is
ejected using a
rack-and-pinion
mechanism
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Abhishek Singh certainly likes it.
Motivated by the desire to build
something physical, and spurred
on by his love of animated GIFs
(“my earlier projects have revolved
around them as well,” he tells
us), he has harnessed the power

of the Raspberry Pi and moved
the instant camera into the 21st
century. By inserting a cartridge
with a tiny screen into his cool
retro-inspired invention, you can
record a GIF, wait for the cartridge
to pop out and, after a few seconds,
watch and enjoy the mini-video.
What’s more, the device looks
just like a vintage Polaroid
OneStep camera.
“Something about holding a
moving image sounded intriguing,”
Abhishek explains. “It’s instantly
relatable, and it has the unique and
exciting interaction of a physical
image coming out immediately that
you can hand to a person. I wanted
to recreate the experience of a
Polaroid in a new way.”
raspberrypi.org/magpi
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INSTAGIF NEXTSTEP

SNAP HAPPY

>STEP-01

>STEP-02

>STEP-03

There wasn’t much space for the
components in this build. Abhishek
fitted a 2.8-inch PiTFT screen into the
cartridge, and he chose a 400 mAh
LiPo battery to power the cartridge
when it’s ejected.

A Raspberry Pi Zero W was soldered
to the screen. Abhishek removed the
header pins from the screen, sanded
down the Pi’s micro USB ports and PCB,
and removed the top casing from the
HDMI port.

The cartridge is charged by a PowerBoost
1000C charger in the camera. Python and
Node scripts run in the camera, handling
the connections and camera control.
Clicking the button starts and stops the
GIF recordings.

Inserting the components

Instant design

To begin with, Abhishek sketched
out his plan on paper, before
turning to Autodesk Fusion 360.
His design had to take two units
into account: the camera (dubbed
CamPi) and the cartridge (SnapPi).
To produce the camera, he used
a Raspberry Pi Camera Module,
an iPhone lens, and an 8GB SD

Using a Pi Zero

The Pis were trimmed and
sanded. The Ethernet port and a
dual USB port were removed from
the Raspberry Pi 3, so the mounting
holes could be used for the
camera chassis. Four circuits were
produced to manage the wiring and
distribute power, and Abhishek
made his own USB cables. Major
issues included finding a suitable

For me, it was not so much about
the learning curve being steep as
about finding creative solutions
card. The cartridge uses a 2.8-inch
screen and another 8GB SD card. A
Raspberry Pi Zero W was fitted into
the cartridge, and a Raspberry Pi 3
was used in the camera.
“I had to think and visualise ways
of assembling the thing, and look
at how it would be disassembled if
I had to troubleshoot something,”
explains Abhishek. “I needed to
consider how everything would fit
together and be placed to minimise
the size. A lot had to be done to
conserve space, and I mutilated
both of the Raspberry Pis I used in
the project quite a bit, but that’s
what made using them so great.”
raspberrypi.org/magpi

Charging up

were ready, it was simply a case of
assembling them into the printed
plastic components that made up
both the camera and the cartridge.
Finally, Abhishek could point the
camera, press the record button,
and watch as the cartridge popped
out and the GIF appeared.
Was it worth it? “The reaction
has been super-positive,” he says.
“For me, it was not so much about
the learning curve being steep as
about finding creative solutions to
the problems that arise every step
of the way.”

way of ejecting the cartridge from
the camera (Abhishek chose a
rack-and-pinion mechanism with
wheels to eliminate friction), and
solving a wide-angle problem.
“But I like the community the Pi
has,” he says. “A solution to the
problem you are facing is probably
out there somewhere.”

Instant success

It helped that he split the project
into small, doable chunks.
“It meant I could go through an
individual process of iteration,
testing and refinement,” he adds.
Indeed, once the working pieces

The parts were printed using a Project 7000 SLA printer,
before being sanded and painted
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MARK WILLIAMS
Mark is a co-founder of Ozzmaker,
which makes and sells Pi add-ons in
Australia – including the BerryGPSIMU unit used in this project.
ozzmaker.com

PI CAMERA CAP
Quick
Facts
> The build
details are at
magpi.cc/
2xhKuZq
> A BerryGPSIMU provides
geotag data
> A GPS fix takes
10–15 minutes
> The main
software is a
Bash script
> The data can
be used to map
your route

Rather than keeping it under his hat, Mark Williams
reveals how he made his GPS-equipped camera cap

ho needs Google Glass
to produce a first-person
visual record of their
day, when you can make a DIY
camera cap? That’s just what
Mark Williams did, using an old
Nike baseball cap, a Raspberry
Pi Zero, and a Camera Module.
Not only that, but he’s added
one of his own BerryGPS‑IMU
boards, created with his
colleagues at Ozzmaker.
The BerryGPS-IMU obtains GPS
coordinates to geotag the photos
taken, as well as logging the

W

altitude (with a pressure sensor)
and ‘attitude’ – pitch, yaw, and roll
– of the camera, to enable images
to be subsequently corrected to
appear perfectly horizontal.
“I saw an old article about
recording GPS, pitch and roll
angles of photos and I thought
the Pi Zero with a BerryGPS-IMU
could pull this off nicely,” explains
Mark. “Originally I was going to
place it in the top pocket of a shirt.
However, placing it in a cap would
give you a wider range to take
photos in: just look and shoot!”

Building and coding

While embedding the Pi Zero
and BerryGPS-IMU in the cap
was very quick and easy, it took
Mark about a week to come up
with the main Bash script that
calls Python code and other tools
to perform various functions.
“My thinking was that I already
have Python code to track GPS
and read the IMU. Raspistill was
used to take photos and Exiftool
was used to edit EXIF data in the
photos. I just needed to put it
all together.”

The camera device is
mounted on a regular
Nike baseball cap

The BerryGPS-IMU
provides GPS coordinates
and other data

A basic camera mount
was made from 3 mm
laser-cut acrylic
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PI CAMERA CAP

PUT A CAMERA IN YOUR CAP

>STEP-01

>STEP-02

>STEP-03

The BerryGPS-IMU is placed on top of the
cap’s visor, with the Pi Zero underneath,
connected via holes. A laser-cut acrylic
mount holds the Camera Module.

To detect whether a satellite fix has been
obtained by the BerryGPS-IMU board, its
fix pin must be connected to a GPIO pin
on the Raspberry Pi.

The Camera Cap is powered by a
small 3.6 V LiPo battery, connected
to the Pi via an Adafruit PowerBoost
1000. It delivers 1.5 hours of use.

Customise a cap

Mark informs us that obtaining
a GPS fix typically takes 10 to
15 minutes. “As long as the
BerryGPS-IMU module has
access to the sky, no antenna
is needed.” He has tested the

Connect GPS fix pin

Power it up

fix, it performed well. Most of the
issues I had were with the script
not starting up correctly when
the Raspberry Pi was powered
on. I also had to fiddle with
the settings for taking images.

Once I had a GPS fix, it performed
well. Most of the issues I had
were with the script
Pi Camera Cap outside on a few
occasions, including a stroll
around Sydney Harbour, taking
pictures of the famous bridge and
opera house. “Once I had a GPS

At first I tried to take a photo
every five seconds by removing
the delay from raspistill, but
this resulted in the Pi camera
not being able to focus.”

Above Software such as GeoSetter (Windows) can be used to show a map location,
and even the camera direction, for each photo taken

raspberrypi.org/magpi

Photographic record

The cap is powered by a small
3.6 V LiPo battery. Connected
to the Pi Zero via an Adafruit
PowerBoost 1000, it can power
the device for up to 1.5 hours.
By default, the camera is set to
take a photo every two minutes,
but this can easily be altered. “I
would say time-lapse is possible;
the lowest interval I had where
the image quality was still good
was 20 seconds.” There’s also the
possibility of shooting video.
Mark says he has received some
strange stares while wearing
the cap in public. “I think the
outward-facing Pi camera and the
size of its PCB makes it obvious
something strange is going on
with my cap.” As for needing to
visit the bathroom, he advises it’s
“best just to take the cap off!”

Above Mark
wore the cap on
a stroll around
Sydney Harbour,
taking photos of
landmarks such as
the famous ‘coat
hanger’ bridge
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ROBERTO TYLEY
An open-source enthusiast, Roberto
develops software for The Guardian,
and authored the BFG Repo-Cleaner.
magpi.cc/2wVeHNE

MESMERIC
MIRROR
Looking to brighten a dark
bedroom, Roberto Tyley decided
to cast fresh light on the idea of a
motion-sensing illuminated mirror

Quick
Facts
> It took nine
months to build
> The laser
was £139 and
the project
cost £250
> Roberto used
an eyeball-safe,
low-power
Class I laser
> A Bluefruit EZKey acts as the
on/off switch
> Find the Python
code at
magpi.cc/
2wURUBy

n reflection, he could have
just bought a lamp. But
after Roberto Tyley stood
on one too many of his children’s
toys in the dark corners of his
bedroom, and decided it was time
for some additional light, he was
hit by a flash of inspiration.
What better way of illuminating
the room, he mused, than a fulllength portrait mirror that would
shine brightly whenever anyone
wandered by? One with individually
controllable LED lighting that
would directly respond whenever
someone posed in front of it,
perhaps? As light-bulb moments
go, he admits it was certainly high
on the wacky scale.
But Roberto saw the potential for
both practicality and fun. “The idea
was to have a mirror that would
know if my children were waving
their hands around,” he explains.
“I wanted the lights to move and
sparkle around their fingers as
they did so.”

O

This shelf of electronics
effortlessly slides into the
unit, connecting via a MultiBeam XLE power connector

Roberto didn’t want to use
an obtrusive always-on
video camera, so he used a
laser rangefinder instead

Pi-powered

Roberto’s first decision was to put
a Raspberry Pi at the heart of the
build. He had only ever used the
computer once before, to create
a video demonstrating the speed
of a tool he’d written to clean Git
36
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The Adafruit DotStar LEDs
use a simple wiring system,
with four wires controlling
the whole strip
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LET THERE BE LIGHT

My children love it, and they
show it off to their friends
when they come round
repositories. He liked the fact that
the Pi was a fully specced Linux
platform. “It meant I could use the
tools and languages I was familiar
with,” he says.
His next step was to research the
best lighting, and he eventually
chose Adafruit’s DotStar Warm
White LED strips. “They are more
expensive than simple strips, but
they use a pretty straightforward
wiring system,” Roberto explains.
“Adafruit also supplies a nice
Python library to control the strip
from the Pi.”

can uniquely identify the pulses of
light that bounce back, so it’s not
confused by secondary reflections.”
To tie everything together,
Roberto created a simple program
in Python: “The code polls the laser
rangefinder to work out if there is
an object closer to the top of the
mirror than the mirror base. If there
is, it increments the brightness in
an array that tracks how bright all
the LEDs should be.” But it wasn’t
entirely straightforward. Creating
the body of the mirror proved a
daunting task.

Motion sensing

Learning by doing

From there, he looked for a way of
detecting the presence of a person,
before hitting on the idea of a laser
rangefinder. “It occurred to me
that if I had a laser rangefinder
pointing straight down from the
top to the bottom of the mirror, in
the same axis as the LEDs, it could
sense how high up anything was,”
he continues.
This would allow the LEDs to
light up to the height of a person,
or work out if they were stretching
their arm up, and illuminate
further. “I decided to use the
LIDAR-Lite rangefinder, which is
a pretty cool but pricey sensor that
encodes digital fingerprints into
the bursts of laser light it sends
out,” he tell us. “This means it
raspberrypi.org/magpi

“Before I started, I had zero
woodwork skills – I’d been terrible
at it at school,” Roberto admits. He
watched several YouTube videos
about making mirror frames (“the
opposite sides really need to be
the same length,” he laughs) and
he also ended up buying all kinds
of powerful tools to get really
accurate mitre joints.
Still, it was worth it. During the
grand unveiling, accompanied
by the sounds of 2001: A Space
Odyssey, he watched the delight
on his children’s faces. “It had
become an almost embarrassing
addiction,” he says of the process.
“But my children love it, and they
show it off to their friends when
they come round.”

>STEP-01

The handy compartment
The electronic components sit inside this removable,
easily accessible shelf. It includes a Raspberry Pi,
backplane connector, speaker, laser rangefinder, AC
power in, and power supply. The decorative brass
grille provides ventilation.

>STEP-02

Fixing the lights
The LEDs fit behind the mirror’s frame. “Problem is,
they have a tiny computer running in each pixel, so
extra power taps are needed every metre or so to
keep the voltage level high,” says Roberto.

>STEP-03

Connecting everything up
The key I/O components use four-wire connections: I2C
for the LIDAR-Lite and SPI for the DotStar. Thankfully,
the Pi can handle both. Roberto soldered the
connections to an easily attachable Perma-Proto HAT.
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Rotary knobs control
parameters such as attack,
release, modulation,
detune, and delay

TOBY HENDRICKS
Colorado-based musician Toby
performs as Otem Rellik, using mostly
homemade electronic gizmos. His
latest album, unbroken&unheard, is
available from Bandcamp and various
streaming services.
otemrellik.com

RGB LEDs under the
touchscreen overlay depict
notes and menus

Two push-buttons are
used to access and cycle
through menu screens

FM TOUCH SYNTH
Quick
Facts
> It took a month
to build and
program
> A resistive
overlay is used
(magpi.cc/
2gJSZll)
> Sounds can be
stored in eight
patch presets
> LEDs are used
to display notes
and menus
> A Teensy
3.6 handles
controls and
audio output
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Frustrated by unreliable iPad music apps, Toby Hendricks built
a homemade touchscreen synth based on a Raspberry Pi Zero
ot long after impressing
us with his Raspberry
Pi Looper ‘synth drum
thing’ (magpi.cc/2xZTAXR),
Toby Hendricks (also known as
Otem Rellik) is back again with
another Pi-based musical device.
This time he has constructed
a touchscreen synthesiser
that offers a wide variety of
stunning sounds, modified using
a combination of rotary knobs
and touchscreen control.
“It went through several
iterations before I settled on
the final design,” Toby tells us.
“The original idea was to have
two touchscreens for two-voice
polyphony, but that ended up being
a bit too large, so I went with one.”

N
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Zero debut

While a Teensy 3.6 board is used
to handle the control data, all the
audio – created using a combination
of FM and subtractive synthesis –
is processed in Pure Data on a Pi
Zero. “This was my first project
using the Zero,” says Toby. “I
just wanted to see if I could run a
somewhat simple Pure Data patch
on a Zero without any audio glitches
(and it turns out I could). Size was
definitely a factor: I wanted to make
a really slim, sleek instrument.”
Toby says the Pure Data
programming language is easy to
use. “Once you learn the basics,
you can do so much with audio and
MIDI. It’s a visual programming
language, so instead of writing

code line by line, you create objects
and start connecting patch cables.
It’s great if you are coming from
a non-technical perspective
because everything is so easy
to understand visually.”

Touch the music

While the synth’s rotary knobs
are used to control aspects such
as attack, release, frequency
modulation, detune, and delay,
the main input interface while
playing and creating new sounds is
the touchscreen overlay. Columns
of RGB LEDs placed beneath it
depict eight notes (the scale of
A minor), while the position of
the player’s finger modifies the
sound produced.
raspberrypi.org/magpi
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BUILD A
TOUCHSCREEN
SYNTH

>STEP-01

Making a case
Rather than displaying
information on a regular
touchscreen, Toby opted to use LEDs
for everything, including menus.
“It’s a bit more archaic and cryptic.
I like to make instruments that you
really have to learn to use, and aren’t
immediately super-accessible. Sort
of like the old hand-held video
games I grew up with.”
One drawback is that the
resistive overlay can only handle
one touch at a time, although a
workaround involves sustaining
notes. “I added the sustain feature
close to the end of the project
because I wanted polyphony. The
synth just sounds so massive when
you play it polyphonically. Perhaps
in the future I’ll upgrade the screen
to allow multitouch.”

Above Toby is pleased with the case,
crafted using his new CNC machine:
“I think all my future projects will have
wooden cases”

Live project

Toby has already used the FM
Touch Synth in live performances.
“It’s working out great! I’ve
been doing a lot of ambient jam
sessions with it, turning the delay
way up and feeding into my Pi
Looper. It’s been a lot of fun.”
Toby would really like to make
the synth available commercially,
which is why he hasn’t released
the code yet, but he’s already
working on another Pi Zero
project: “a looper in which
you can manipulate the pitch
and speed of the loop in four
different slots.”

The menus are a
bit hard to fathom
at first sight, but
they include
presets, sound
parameters,
vertical position
effects, and a
voice level mixer

raspberrypi.org/magpi

The wooden case was Toby’s first project using
his new CNC machine. It houses the components,
including the matrix of RGB LEDs that sit under the
touchscreen overlay.

>STEP-02

Teensy bit of help
Eight rotary knobs and the touchscreen overlay are
wired up to a Teensy 3.6, which sends control data
to the Pi Zero and also handles audio output.

>STEP-03

Pure Data programming
All the synthesiser sounds are processed on the Pi
Zero using Pure Data, a visual programming language
in which objects can be created and linked together.

October 2017

39

Tutorial

RASPBERRY PI 101: EDIT IMAGES ON YOUR RASPBERRY PI

EDIT IMAGES

ON YOUR RASPBERRY PI
You’ll
Need
> Raspberry Pi
> Raspbian
> Mirage

In spite of its size, the Raspberry Pi makes a powerful
image-editing machine
hen it comes to image editing on the
Raspberry Pi, you have several options.
The default program, called Image Viewer,
is based on GPicView. It’s extremely fast and
lightweight, and you can use it to rotate images.
At the other end of the scale is GIMP. Raspbian is built
on top of Debian, and most Linux users reach for GIMP
(GNU Image Manipulation Program) for heavy image
editing. It’s capable of professional image retouching,
including perspective distortion and channel mixing.
The good news is that GIMP runs just fine on a
Raspberry Pi. It could be accused of being overkill for
quick image manipulation, but if you want to go the
whole hog, enter:

W

sudo apt-get install gimp
Then head over to the GIMP Tutorials page to find
out what you can do (gimp.org/tutorials).

MIRAGE

In our tutorial, we’re going to use something a little
lighter, and a little cooler.
We’re going to install a program called Mirage.
This is a lightweight photo viewer that can also resize,
crop, rotate, and flip images. It features basic colour
editing and file management, and it’s perfect for our
lightweight needs:

sudo apt-get update
sudo apt-get install mirage

HOW TO:
EDIT IMAGES
IN RASPBIAN
>STEP-01

Open in Image Viewer
If all you want to do is view a file, then double-click
on it in File Manager (or use xdg-open and the file
name in Terminal). The Image Viewer app will open,
enabling you to view the image. You can use the yellow
Rotate and Flip buttons to flip the image around.

01

The Thumbnails pane
enables you to view all the
images in a folder at once
Mirage has more powerful image
editing tools than the Image Viewer app
included with Raspbian
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EDIT IMAGES ON YOUR RASPBERRY PI
02

05

>STEP-02

Open Mirage

For slightly more power in your image editing, open
Mirage (Menu > Graphics > Mirage). Now, choose File
> Open Image and pick an image on your Raspberry Pi.
The Thumbnails Pane on the left shows all the other
images in the same folder, which makes it easy to
switch between images.

03

>STEP-05

Resize an image
Sometimes you need an image set to a specific size, for
use on a webpage or to display accurately in a document.
Choose Edit > Resize to open the Resize Image window.
Adjust the properties in the Width or Height boxes to
adjust the image size. By default the image will maintain
its proportions; deselect the ‘Preserve aspect ratio’ box
to adjust the Width and Height independently.

06

>STEP-03

Rotate images
It’s easy to rotate images. Select the image in the
Thumbnails page and choose Edit > Rotate Left/Rotate
Right. Use Flip Vertically and Flip Horizontally to
mirror-flip the image.

04

>STEP-06
>STEP-04

Crop an image
Choose Edit > Crop to open the Crop Image window.
You can draw a marquee selection box around the
smaller image in the preview window. Its dimensions
will display in the X, Y, Width, and Height text boxes
(these values can be changed manually). Press Crop to
remove the unwanted part of the image.
raspberrypi.org/magpi

Saturate

While Mirage doesn’t have the powerful
colour-correction facilities of GIMP, you can adjust
the colour saturation (which is often the best tool for
touching up an image). Choose Edit > Saturation and
use the Saturation level slider to change the value. As
you move the slider, the image will display the new
levels. Press Saturate when you’re happy with the
image. Use File > Save Image to keep your edits.
xxxxx 2016
October
2017
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RASPBERRY PI 101: USE PDFS ON RASPBIAN

USE

PDFS

ON RASPBIAN
PDF is a great format for sending and sharing documents, but you can do an
awful lot more with a PDF file if you know how

You’ll
Need
> Raspberry Pi
> Internet
connection

DF documents have all kinds of uses, from
receipts and invoices from online shops, to
newsletters and magazines – including this
one. Whether you’re reading this article in print or
as an electronic document, the pages you are reading
began as PDF files, which are either sent to a printer
or uploaded to the web.
There’s a reason for this. PDFs are excellent at
preserving complex layouts of text and graphics,
meaning that the recipient sees exactly what you
intended them to see, regardless of the device and
software used.
As well as guaranteeing quality and consistency
when distributing documents, the PDF is an excellent
tool for archiving documents and information.
Rather than printing a receipt from a website or a
document you’ve created, save it as a PDF (often

P

called ‘printing to file’). This lets you keep a record
that doesn’t take up any space, and which you can
find easily without rifling through a filing cabinet
or a stack of paper.
While we often think of PDF as a read-only file
type – something that we can only look at – modern
PDF software allows us to edit almost any PDF. For
example, if a school emails a PDF letter asking for
contact details, you can type those details into the
PDF, save it, and email the completed form back.
No more printing forms and hoping your child
remembers to hand them to the teacher.
The good news is that you can complete all these
tasks using a Raspberry Pi. This includes using the PDF
viewer built into Raspbian to open, save, and print
documents – but we’ll also show you how to install
a more advanced PDF viewer to edit your PDF files.

Raspbian
comes with a
PDF viewer, so
you can use PDFs
immediately

The PDF
viewer (XPDF) is
basic, but it can
open a complex
PDF perfectly

Use these
tools to search or
print the PDF, and
to make it more
readable
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01

>STEP-04

04

Searching a PDF
You can search a PDF for specific
words by clicking the binoculars
button at the bottom of the
window. Use ‘Match case’ or ‘Whole
words only’ to narrow your search.

>STEP-05

Printing a PDF
To print your PDF, click the printer
button at the bottom of the
window. You can print the whole
document, or a range using the
Pages boxes.

>STEP-01

Saving PDFs

Whether you’re viewing a PDF from an email, a
download, or a USB drive, save it to your Pi as you
would any other file.

05

>STEP-06

Installing Okular
02

If you want to edit a PDF, you’ll
need to install Okular. Go to Menu
> Preferences > Add/Remove
Programs. Search for Okular, tick
the box, and click OK. To open a
PDF in Okular, right-click on the
file and select Okular.

06

>STEP-02

Opening a PDF
Double-click on a PDF file and you will be asked
which application you would like to use to open it.
Open Accessories to select PDF Viewer, and tick the
box at the bottom to set PDF Viewer as your default
PDF program.

03

>STEP-07
Editing a PDF

Open the Tools menu in Okular and click Review
to show the editing tools sidebar. To highlight or
underline text, select the text with the cursor (as in
a word processor), and click the relevant tool button.
You can also add notes and shapes to the document.

07

>STEP-03

Adjusting the view
To resize your PDF to fit the window, open the zoom
menu (click the downwards arrow next to the size box
at the bottom of the window). Choose a size, or use ‘fit
width’ if you want the PDF page to be the same width
as the window.
raspberrypi.org/magpi
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WALKTHROUGH

MIKE’S PI BAKERY

MIKE COOK
Veteran magazine author from the old
days and writer of the Body Build series.
Co-author of Raspberry Pi for Dummies,
Raspberry Pi Projects, and Raspberry Pi
Projects for Dummies.
magpi.cc/259aT3X

THE LARGE
HEAD ‘N RON
COLLIDER

Make a spooky
reaction game for
your Halloween party

You’ll
Need

t is time for our annual Halloween project, and
publishing this at the end of September gives
you plenty of time to get it working for your
Halloween party. This time, it’s a game with Head the
Skull and Ron the Pumpkin, in a race to detect the

I

spooky particles that are emitted when they collide at
speed. Just like many of the world’s colliders, it works
by sending Head one way round a ring of accelerators,
and Ron in the opposite direction. All you have to do is
to press the foot switch at the instant they pass each

> 12 × mini skull
string lights
> 12 × mini pumpkin
string lights

Connections to the Pi’s GPIO ports

> One red/green
common cathode
LED
> Foot-operated
switch and jack
socket
> GPIO connector
> Resistors
and wire
> Strip pine and
MDF sheet
> M3 nuts
and bolts

The green LED is
the speed indicator

The illuminated
skull indicates
the Head
stream position

44

October 2017

The illuminated pumpkin
indicates the Ron
stream position
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Figure 1 The two strings of LEDs we used for this project

Reflecting surface
Cone shaped indent

other, once they have accelerated up to full speed.
You know when they are up to speed because a speedmonitoring LED at the centre of the collider changes
from red to green.

The circuit

We used two very cheap sets of string lights, obtained
from our local pound shop, as shown in Figure 1.
Surprisingly, they each cost a pound. The LEDs are
wired in parallel, and utilise the internal resistance
of the batteries to keep the LED current in check. In
this project, we are going to control them from the
GPIO ports of the Raspberry Pi, and provide a real
resistor in series with each LED. This project uses all
but one of the GPIO pins on the connector, including
the I2C HAT identification pins. The LEDs themselves
are rather interesting, as they are designed with a
360-degree viewing angle. They use a cone-shaped
indent which acts as a reflecting surface, spreading
the light all round, as shown in Figure 2.
The schematic for our game is shown in Figure 3
(overleaf), and is pretty straightforward, using LEDs
and a switch. The common cathode tri-colour LED
is simply a red and a green LED in one package.
As there is no data sheet for the string light LEDs,
we had to experiment to find out which resistor
values produced which levels of current. The
forward voltage of the LEDs is close to the 3V3 of
the GPIO pins, so we only need low-value resistors
to run the white and orange LEDs at 5 mA and
4 mA respectively.

raspberrypi.org/magpi

Light rays

Light rays

LED chip

Figure 2
A 360-degree LED

Wires

At a cursory glance, you might think that we are
overloading the current capability of the GPIO pins
(51 mA in total), but the project will only illuminate
one LED at a time for the Head and Ron groups, plus
one of the two speed LEDs. We could have opted for
full buffering and driven the LEDs at 5 V, along with
a much higher current, but in the end we chose the

October 2017
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MAKING
THE LARGE
HEAD ‘N RON
COLLIDER

Outer ring - Head’s positions 150 mm radius
10
11

9

0

8

>STEP-01

Making the board

30°
7

1

Take a piece of 6 mm thick MDF, 330×330 mm
in size. Drill a hole in the centre and mark
two circles of 150 mm and 120 mm radius,
centred on the same point. We made a strip
of Perspex with three holes, and used a
screw in the centre and a pencil in each hole
to draw the circles. Then we then used a
30-degree set square and a ruler to mark the
position of the mounting holes, and drilled
them with a 3 mm drill bit. Next, we glued on
20 mm stripboard to make a tray, painted it
all with a flat black paint, and filed a slot on
the right-hand side for the foot switch cable.
Finally, we filed a slot on the back edge, near
position 10, for the 40-way ribbon cable.

2

6

3

5
4

Inner ring - Ron’s positions 120 mm radius

Figure 3
Schematic for the
Head ‘n Ron game
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>STEP-02

Prepare the LEDs
Separate the LEDs by starting at the end of
the string and snipping off the two wires,
close to the next LED. Repeat this until all
the LEDs have two long and two very short
wires coming from them. Identify the anode
and cathode by applying a voltage (3 to 5 V)
through a 470R resistor. The cathode will
be the one at the negative terminal when
the LED lights up. Identify the cathode with
a blob of correcting fluid, or by making the
wire 5 mm shorter than the anode. Finally,
trim off the shrink insulation from the sides to
reveal the two short stubs of wire. Cut these
as short as you can so that they are covered
by the insulation. This should leave two
longer wires.

Figure 4 Hit your foot switch now!

simplest and cheapest option. If you want to develop
other games with more LEDs, we would recommend
using a buffer, such as the ULN2003A.
The construction of the project is shown in the
steps, and takes a bit longer than you might think.

The game

The game takes its inspiration from other forms of
large colliders. The two streams go round in opposite
directions. When they meet, they are diverted into
the same path, and they collide. You have a foot
switch to press when the two streams are at the
same point.
Watch out – with 12 positions per circle, and
moving at the same speed, there may never
be a time when the two streams are at the same
point. The trick is to make them move at different
rates. What’s more, it takes time for the streams to
accelerate to a colliding speed, and this is signalled
when the central LED turns from red to green. If you
press the foot switch at the right time, as shown
in Figure 4, the screech of fundamental spooky
particles is released, and the collider starts again
– only this time it goes faster! Once you miss, the
round ends, and you’ll be given a score based on the
number of correct hits.
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WALKTHROUGH
>STEP-04
Wiring it up

>STEP-03

Mounting the LED shells
Separate the two halves of the plastic skull
and pumpkin LED covers. Drill a 3 mm hole in
the base of the back half of each cover, and
attach each one to the top of the box using
a 10 mm M3 screw and nut. For positions 9
and 11, use a 10 mm threaded pillar instead
of a nut, as these will act as a mounting for
the stripboard. Drill a 5 mm hole in front of
each half shell, as close to it as you can, and
insert an LED of the appropriate colour. Fix
the LEDs in place with hot-melt glue from the
underside of the board. Finally, cut holes in
the bases of the remaining front-half covers
to fit around the LEDs, and clip the front and
back of each cover back together.

Software

The software uses the Pygame framework to
produce the sound. Make a directory called Sounds
in the same directory as the program, and copy
into it the files Screech.wav and Spiral.wav from
the directory /usr/share/scratch/Media/Sounds/
Electronic. Most of the action is controlled by the
playRound function, which contains a state machine
that decides which (if any) of the streams to move,
based on the elapsed time clock. It returns a true or
false signal to indicate whether or not the round
is over. The variables rInterval and hInterval
control the speed of each stream, and the variable
speedThreshold determines when they reach a
speed suitable for collision. Altering the speedInc
variable controls how quickly the streams accelerate
up to speed.

Taking it further

You can adjust the variable controlling the final
speed of the game, but at its fastest it is quite tricky.
The initial slow start ensures that everyone can
manage at least one hit. You could add extra sound
effects, such a clunky whine as the accelerator ramps
up, or a spooky cackle if you miss.
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Mark the positions (Head 1–12 and Ron 1–12) on the underside
with a pencil so you can identify the LEDs. Wire the GPIO
connectors to the appropriate LEDs through the appropriate
resistors. We used surface-mount resistors on the back of the
stripboard, mainly because we had them in stock at the right
value – there is no advantage to using surface-mount resistors
over through-hole resistors here. Don’t forget to add the jack
for the foot pedal as well – it doesn’t matter which way around
you attach it to GPIO 2. Use the threaded pillars to attach the
stripboard to the underside of the game, and the ribbon cable
to attach the game to the Raspberry Pi. Do not underestimate
the length of time it will take to complete this step – it took us
over four hours, including using heat-shrink sleeving to extend
the LED wires.

head _n_ron.py
001.
002.
003.
004.
005.
006.

import pygame,time, random
import RPi.GPIO as io

Language
>PYTHON
DOWNLOAD:

magpi.cc/1NqJjmV

pygame.init()
PROJECT
pygame.mixer.quit()
VIDEOS
pygame.mixer.init(frequency=22050,
size=-16, channels=2, buffer=512)
Check out Mike’s
007. random.seed()
Bakery videos at:
magpi.cc/1NqJnTz
008.
009. def main():
global score, rightSpeed, speedThreshold, hInterval,
010.
rInterval
global countR, countH
011.
print("Head n Ron collider game")
012.
print("Ctrl C to quit")
013.
init()
014.
while 1:
015.
clr()
016.
countR = random.randint(0,11)
017.
countH = random.randint(0,11)
018.
score = 0
019.
hInterval = 2.0 ; rInterval = 1.5
020.
speedThreshold = 1.0
021.
io.output(speed[0],1)
022.
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023.
io.output(speed[1],0)
024.
rightSpeed = False
025.
while playRound(): # keep going until you miss
026.
pass
027.
miss.play()
028.
print("Score",score)
029.
a = input("Press return to play again")
030.
031. def playRound():
032.
global countH, countR, lastRon, lastHead, overlap,
score
033.
global rightSpeed, rInterval, hInterval,
speedThreshold
034.
done = False
035.
if time.time() - lastRon > rInterval:
036.
countR = moveR(countR)
037.
lastRon = time.time()
038.
if countR == countH:
039.
if io.input(2) ==1 :
040.
overlap = True
041.
042.
if not rightSpeed and rInterval > speedInc:
043.
rInterval -= speedInc
044.
hInterval -= speedInc
045.
if rInterval < speedThreshold:
046.
io.output(speed[0],0)
047.
io.output(speed[1],1)
048.
rightSpeed = True
049.
if time.time() - lastHead > hInterval:
050.
countH = moveH(countH)
051.
lastHead = time.time()
052.
if countR == countH:
053.
if io.input(2) ==1 :
054.
overlap = True
055.
056.
if countR != countH and overlap: # have they passed
057.
overlap = False
058.
059.
if io.input(2) ==0 :
060.
if overlap and rightSpeed:
061.
print("bang")
062.
bang.play()
063.
while pygame.mixer.get_busy():
064.
pass
065.
overlap = False
066.
# make go faster
067.
if speedThreshold > speedInc:
068.
speedThreshold -= 0.1 #change colliding speed
069.
hInterval = 2.0 ; rInterval = 1.5
070.
score +=1
071.
io.output(speed[0],1)
072.
io.output(speed[1],0)
073.
rightSpeed = False
074.
time.sleep(0.8)
075.
else:
076.
if not rightSpeed:
077.
print("not going fast enough")
078.
else:
079.
print("not in the right position")
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080.
done = True
081. return not done
082.
083. def moveH(count):
084. io.output(heads[count],0)
085. count += 1
086. if count > 11:
count = 0
087.
088. io.output(heads[count],1)
089. return count
090.
091. def moveR(count):
092. io.output(rons[count],0)
093. count -= 1
094. if count < 0:
count = 11
095.
096. io.output(rons[count],1)
097. return count
098.
099. def init():
100. global heads, rons, speed, hInterval, rInterval
101. global countH, countR, lastRon, lastHead, overlap
102. global rightSpeed, speedInc, speedThreshold, bang,
miss
103. countH = 4 ; countR = 0
104. lastRon = time.time()
105. lastHead = time.time()
106. overlap = False ; rightSpeed = False
107. heads = [14,15,18,23,24,25,8,7,12,16,20,21]
108. rons = [3,4,17,27,22,10,9,11,5,6,13,19]
109. speed = [0,1] #speed LED
110. hInterval = 2.0 ; rInterval = 1.5
111. speedInc = 0.1
112. speedThreshold = 1.0
113. io.setwarnings(False)
114. io.setmode(io.BCM)
115. io.setup(heads, io.OUT)
116. io.setup(rons, io.OUT)
117. io.setup(speed, io.OUT)
118. io.setup(2, io.IN) # foot switch
119. bang = pygame.mixer.Sound("sounds/Screech.wav")
120. miss = pygame.mixer.Sound("sounds/Spiral.wav")
121.
122. def clr():
123. for led in range(0,12):
io.output(heads[led],0)
124.
io.output(rons[led],0)
125.
126. io.output(speed[0],0)
127. io.output(speed[1],0)
128.
129. # Main program logic:
130. if __name__ == '__main__':
131. try:
main()
132.
133. finally:
clr()
134.
pygame.mixer.quit()
135.
pygame.quit() # close pygame
136.
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K.G. ORPHANIDES
K.G. has been writing about technology
and sound for two decades, and can be
heard on podcasts with subjects ranging
from gaming to political philosophy.
twitter.com/KGOrphanides

MAKE A

You’ll
Need
> A microphone
>S
 peakers or
headphones
> Audacity
>G
 oogle account
> Internet
connection

PODCAST
MACHINE

Your Raspberry Pi is a perfect pocket-sized PC for podcasting – we’ll show
you how to record, edit and publish your own online radio programme

lthough it’s a little short on memory when
it comes to heavy-duty multi-track audio
editing, a passively cooled Pi runs completely
silently, which makes it easy to create clean voice
recordings with minimal background noise.
These instructions will work perfectly on any
Debian-based Linux distro, such as Raspbian or
Ubuntu MATE. As you’re going to be recording raw
PCM audio, we recommend using a reasonably large
microSD card if you plan to keep previous recordings
for posterity.
Although we’ll be exporting the audio files at a
lower quality, we recommend recording at a minimum

A

sample rate of 44.1 kHz. This is Audacity’s default
setting, so you won't need to change anything.

>STEP-01

Get connected
Connect your speakers and microphone to your
Pi. You can get away with using your TV’s built-in
speakers via an HDMI connection, but connecting
headphones to the 3.5 mm analogue port makes for
a more private editing experience.
A USB gaming headset with a built-in microphone
will do in a pinch, but we recommend a USB condenser
mic for better quality voice recording. We’re fans

OPTIMISE
ANALOGUE
AUDIO
QUALITY
The Pi’s
headphone
port can add
unwanted
background
noise. To
minimise this,
set your mixer
volume to
100 percent
and use a
good-quality
power supply.
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You can select external audio
devices using Audacity’s
pull‑down menus

Audacity defaults to a sample
rate of 44.1 kHz, which is fine
for most recording projects,
including this one
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of the Blue Microphones Yeti, but you can get good
budget options such as the Blue Snowball iCE and
Samson Go Mic for less than £50.

>STEP-02

Record your podcast
Install Audacity by opening a Terminal window and
typing sudo apt-install audacity. Open the
program, and make sure it is using the correct audio
input and output devices by checking the device
pull‑downs on the taskbar, or by opening Preferences
from the Edit menu.
Before you start recording, we recommend
writing a script or prompts to work from. If you
stumble, just pause, go back a few sentences and
start again – you can cut out the error later. For
easier editing and processing later, it is often more
convenient to break longer recordings into 10- or
15-minute chunks.

>STEP-03

Edit and process
Once you’ve finished recording, it’s time to edit
out any errors and use a few effects to improve the
recording’s quality.
To reduce background noise such as computer
or fan hum, highlight a few seconds of audio with
only background noise. Select Noise Reduction from
the Effect menu and select Get Noise Profile. Then
select your entire track, open Noise Reduction again,
and hit OK.
To balance and amplify your recording if it’s
too quiet, select the entire track and apply the
Normalize effect using its default settings. Finally,
go to File > Export Audio, and encode your recordings
as MP3s – we recommend 96kbps joint stereo
for voice.

>STEP-04

Create your blog
Go to drive.google.com and log in to the Google
account you want to use. If you don’t already have a
Google account, you can sign up for one on this page.
Go to blogger.com and sign in using your Google
account. Create a Blogger or Google+ account. When
the main Blogger interface loads, hit the Create New
Blog button. Pick a name, custom blogspot URL,
and theme.
To allow MP3 embedding, go to Settings > Other
and switch the Enable Title Links and Enclosure Links
settings to Yes. Now select Save Settings at the top
right-hand corner of the screen.

Above Use
Blogger’s
Enclosure Links
field to post
your MP3 files
once you've
uploaded them
to Google Drive

>STEP-05

Upload your podcast
In Google Drive, create an appropriately named folder.
Set the folder’s privacy to allow ‘anyone with the link’
to view the files in it. Upload your first MP3, rightclick on it and select Get Shareable Link. Copy the link.
Return to Blogger and hit the New Post button. Give
your podcast an appropriate title and description,
using the Title field and Post Body respectively. In the
Post Settings box on the right, select Links. Paste your
MP3’s URL into the Enclosure Links field and give it
a MIME type of audio/mpeg3. Hit Publish, and we're
ready to go live.

>STEP-06

Launch your media empire

Above Feedburner turns your blog into a podcast feed that will
work with popular directories such as iTunes and Stitcher

raspberrypi.org/magpi

Go to feedburner.com and sign in with your
Google account. Paste your blog’s main URL
(yourcustomurl.blogspot.co.uk) into the Burn A Feed
box, tick ‘I am a podcaster’, and click Next.
Select the feed you want to use – we prefer the
longer-established RSS option, but Atom works too.
Feedburner will ask you to confirm the title and the
address you want to use.
Your podcast is ready for subscribers, but you should
click Next to fill in extra information for the iTunes
podcast directory. Feedburner tells you what you need,
including an image and a more detailed description,
and can even provide listener stats.

GET LISTED
For extra
exposure, list
your podcast
on online
directories.
The most
important is
iTunes, which
you can you
join at
magpi.cc/
2x233hl
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BILL BALLARD
Bill is a retired physicist who got back
to his programming roots and found
fun things to do with his ten Raspberry
Pis, even while sailing.
github.com/wpballa

SIMULATE CIRCUITS

WITH XYCE ON PI
Compile Xyce, an open-source state-of-the-art circuit simulator, on a Raspberry Pi

You’ll
Need
> Latest version
of Raspberry
Pi Desktop/
Raspbian
> 1 6GB SD card
(or preferably
a larger solidstate drive or
hard drive)

Below Input [V(101)]
and output [V(VOUT)]
of the operational
amplifier inverter
circuit. Note
transient at start
due to poor initial
condition assumption

here are many circuit simulators, such as
SPICE, TINA or DoCircuits, available for use
in designing circuits. However, most of them
are either limited-use free versions or academic
programs. Xyce is an open-source and fully functional
circuit simulator developed by Sandia National
Laboratories (supported by the US Department of
Energy), that you can compile on a Raspberry Pi.
A quick warning: there are challenges associated
with compiling using the limited memory on a Pi, and
this project will take about a half day to complete,
even on a Raspberry Pi 3.

T

System preparation

Start by updating and upgrading your distribution.
Xyce does not compile on systems with only 1GB of
memory. The minimum recommended is 4GB, so next
we must expand the swap file size to accommodate
the compilation:

sudo nano /etc/dphys-swapfile

Change the CONF_SWAPSIZE from 100 to 2048 (the
maximum possible), save, and exit. Next make the
change effective:

sudo dphys-swapfile setup
When you have compiled the code, you can reset the
swap file to 100Mb if you like.
Install the required utilities for the compilation:

sudo apt-get install gfortran cmake bison
flex libsuitesparse-dev libtool

Install Fourier transform libraries

Next, install the Fortran fast Fourier transform
libraries. Use the Chrome browser to do all the
downloading. Go to magpi.cc/2vI69FW and get
the 3.3.6 release via tar.gz – this will put the file in
your Downloads folder. Navigate to the Downloads
directory in a Terminal window and unzip and extract
the file:

cd ~/Downloads
tar xzf fftw-3.3.6-pl2.tar.gz
Now build and install fftw:

cd fftw3-3.3.6-pl2
./configure
make
sudo make install

Install Trilinos libraries

Next, we install the Trilinos libraries, a very powerful
set of serial and parallel solvers. Go to trilinos.org
and navigate to Download > Previous Releases. In the
Pages section on the right-hand side of the screen,
find the version 12.6.3 link. You want this version
52
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Language

Left Xyce is an open-source, fully functional circuit simulator

>XYCE

The next line places the documentation in the
proper Xyce folder:

FILE NAME:
OP27.CIR

DOWNLOAD:

tar xzf ~/Downloads/Xyce_Docs-6.7.tar.gz

magpi.cc/2vI6loE

Get the file config from the GitHub directory and
make sure it is executable. Then compile and install,
which will take an hour or so.

for Xyce 6.7, as later versions aren’t guaranteed to
work with Xyce. Trilinos is free, but you will need to
sign up to access the files. Download and unzip the
Trilinos files:

cd ~/Downloads
tar -xzf trilinos-12.6.3-Source.tar.gz
The last command places the source code in
~/Downloads/trilinos-12.6.3-Source, but we want
to do an ‘out of source build’, so create a directory
to do this:

cd ~
mkdir Trilinos12.6
cd Trilinos12.6
Xyce only uses some of Trilinos, and there is a
suggested reconfigure file on their build page. You
can find a modified version at magpi.cc/2vI6loE,
called reconfigure. The SRCDIR line assumes you
have followed the instructions above. Make sure that
reconfigure is executable, run it, and then build the
code. The make command will take about an hour and
a half to complete.

MOVING
XYCE TO
ANOTHER PI

chmod u+x config
./config
make
sudo make install
Next, we test things with the regression suite.
Staying in the Xyce-6.7 directory, unpack and execute
the regression suite:

tar xzf ~/Downloads/Xyce_Regression-6.7.tar.gz
cd Xyce_Regression-6.7/TestScripts
./run_xyce_regression

When you
have a
compiled
version,
only the
libsuitesparsedev libraries
and the
compiled code
are required
on another
Raspberry Pi.

The regression suite takes a while to execute. A
few tests related to calling Xyce as a library will fail,
and the huge test problem (RCladder), which uses
more memory than the Pi has, will fail, but the vast
majority should pass.

A sample problem

A favourite test problem is a detailed model of
the OP17 operational amplifier. The net list is
available in the Xyce GitHub, as OP27.cir. Copy
this file to a directory on your Pi, and run Xyce with
the command:

Xyce -l op27.log -o op27.prn OP27.cir
chmod u+x reconfigure
./reconfigure
make
sudo make install

Build Xyce

Download Xyce from magpi.cc/2vIj36H. Register for
free, and the downloads page will open. Grab the files
containing the source code Xyce-6.7.tar.gz, as well as
the regression suite Xyce_Regression-6.7.tar.gz, and
the documentation Xyce_Docs-6.7.tar.gz. These will
arrive in your Downloads directory.

cd ~/Downloads
tar xzf Xyce-6.7.tar.gz
cd ~
mkdir Xyce6.7
cd Xyce6.7

raspberrypi.org/magpi

The log file is defined by -l, -o defines the output
file, and the final argument is the input netlist. This
will only take a few seconds to execute. You can
inspect the op27.log file to see how things went.
LibreOffice Calc can be used to view .prn files, so use
it to open op27.prn. Visualise the output by selecting
the time and voltages, and creating a graph (x-y
line). You can clearly see the inverting nature of this
circuit setup.

Start designing!

Xyce will run most standard netlists for SPICE with
just a few minor modifications. The Xyce Reference
Guide in the Documentation folder lists the specific
changes needed for several popular circuit simulators.
Now you have a state-of-the-art circuit simulator
on your Raspberry Pi for your next design project!
Note that many manufacturers provide free SPICE
models for their components on their websites.

EXTERNAL
HARD DRIVE
Use an
external
solid-state or
hard drive to
speed up the
compilation
and allow
space for
project files.
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LAURA SACH
Laura is Content and Curriculum
Manager at the Raspberry
Pi Foundation.
raspberrypi.org

GET STARTED WITH

NODE-RED
You’ll
Need

> 1 × LED
> 1 × solderless
breadboard
>4
 × male-tofemale jumper
leads
> 1 × 330 Ω resistor
> 1 × tactile push
button
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Learn how to use the visual programming language designed for IoT
n this tutorial, you’ll learn how to use
Node-RED to communicate with the
Raspberry Pi’s GPIO pins. Node-RED
is a drag-and-drop visual tool which comes
pre-installed on Raspbian. Here, we’ll create a
Node‑RED ‘flow’ to control LEDs.
By doing this, you’ll learn how to set up Node‑RED
flows and use them to control GPIO pins. We’ll
also cover how to use Node-RED inputs, outputs,
and a switch (equivalent to a selection statement);
and how to use Node-RED to simulate a NOT gate
acting on inputs from a button.
To start, wire up an LED to GPIO 17 on your
Raspberry Pi. Figure 1 shows how to do this.

I
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The positive leg of the LED is usually longer than
the negative leg, and it is the positive leg that should
be inserted into the left-hand side of the breadboard
in this diagram.

Start Node-RED

Start up your Raspberry Pi. Click on the raspberry icon
in the top left-hand corner of the desktop screen, then
go to Programming > Node-RED. This should launch a
window displaying information about Node-RED.
Now open the Chromium web browser. In
Chromium, type localhost:1880 in the address
bar, then press ENTER. This will display the
Node-RED interface.
raspberrypi.org/magpi
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Figure
Wire up an LED to GPIO
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GP26 GP20
Your
Raspberry Pi does not need to be connected to
GND GP21
the internet to use Node-RED: localhost is the address
the Raspberry Pi uses to refer to itself and :1880
means that it is looking at port 1880.

Connecting to a GPIO pin

_

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
the17
18
19
20

Programs in Node-RED are called flows. You can see
that your blank page is labelled as Flow 1 in the tab at
the top (see Figure 2). You can create as many flows
as you want, and they can all run at the same time.
In this guide, we will create one flow.
The coloured blocks on the left-hand side of
the interface are the nodes. Scroll right down to
the bottom of the list and you will see some nodes
labelled Raspberry Pi.
You will see two nodes with the label rpi gpio:
these are the ones we will use to talk to the GPIO
pins on the Raspberry Pi. The first one in the list,
with the raspberry icon on the left, is for inputs.
Using a button-push to control something would be
an example of an input. The second node, with the
raspberry icon on the right, is for outputs. Switching
on an LED would be an example of an output. Drag
an output node onto the blank page in the middle
of the screen.

Double-click on the node, and a configuration box
will appear (see Figure 3). Change the GPIO pin to
GPIO 17 and make sure ‘Initialise pin state?’ is ticked.
Leave the setting for ‘Initial level of pin’ on low. Give
the node a name – we called it Green LED because
the LED we used was green, but if yours is a different
colour, feel free to change the name. When you have
finished, click Done.

Figure 2 The
default Node‑RED
window as
it appears in
the browser

Injecting messages

Now scroll back up to the list of nodes. To turn the
LED on and off, we need an input. In Node-RED, we
can inject messages into the flow and cause things to
happen as a result. Drag an Inject node onto the flow.
Double-click on the Inject node. Use the dropdown menu next to Payload to change the data type
to string, and type 1 in the Payload box – this will be
the message. Type On in the Name box. Click Done.
Repeat the previous steps to create another Inject
node, but this time add 0 as the payload message,
and call this node Off.
Now look for the grey dot on the right-hand side of
the Inject nodes. Click and drag from the grey dot on
the On node to the grey dot on your LED node to join
them up. Repeat for the Off node, also joining it to
the LED node. Figure 4 shows how this should look.
Flow 1

On

Green LED

Off

Figure 3 Setting up a node for your flow
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Figure 4 Putting the flow together
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msg.payload

On

Green LED
0

Off

Figure 5 The debug
tool allows you to
figure out where
your flow might be
going wrong

Figure 7 Adding a button input is easy

Deploying the flow

Our flow is finished, so now we can deploy it. Click
on the big red Deploy button in the top right-hand
corner of the screen. A message should pop up at
the top saying ‘Successfully deployed’. This is like
pressing the green flag in Scratch, or F5 to run your
code in Python.
Now click on the blue square on the left of the On node
to inject the message 1. The Green LED node receives the
message, and your LED should light up. You should be
able to turn the LED off by clicking the blue square on
the Off node, which injects the message 0.

Debugging your flow

If your LED doesn’t turn on and off, check that
you have wired the components correctly on the
breadboard. Make sure you have wired your LED to
both ground and GPIO 17 on your Raspberry Pi.
You can also ask Node-RED to display debugging
information by wiring up your nodes to a Debug
node, which can be found under Output. Drag in a
Debug node, wire your two Inject nodes to it (see

Figure 5), then click Deploy. When you click the
buttons to inject the message, the Debug tab on the
right-hand side of the screen will show you what
was injected. Click the tab to display the messages.

Adding a button

Now let’s add a button to control the LED. Wire
up your button to the Raspberry Pi as shown in
Figure 6, so that your LED is still connected to
GPIO 17, and your button is connected to GPIO 4.
Remove your Turn on and Turn off Inject nodes
by clicking the node and pressing DELETE on the
keyboard. We no longer need these, as we will be
controlling the LED using a physical button.
Now we need to add a Raspberry Pi GPIO Input
node. This is the node with the raspberry icon on
the left. Set up this node to receive input from your
physical button, as shown in Figure 7.
Specifying pullup means that GPIO 4 will be set
to HIGH, and pressing the button will cause it to
go to LOW.

Figure 6 Wiring
up the button
doesn’t require
much more work

+

3V3

5V

GP2

5V

GP3

GND

GP4 GP14
GND GP15
GP17 GP18
GP27 GND
GP22 GP23
3V3 GP24
GP10 GND
GP09 GP25
GP11 GP8
56

October 2017

GND

GP7

DNC

DNC

_

a b c d e
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17

f

g h i

j

+

_

1
2
3
4
5
6
7
8
9
10
11
12
13
14
raspberrypi.org/magpi
15
16
17

Tutorial

GET STARTED WITH NODE-RED
msg.payload

Button

Change to 0

If input is 1

LED

1

OK

Change to 1

Figure 9 It is very simple to create a working circuit in a Node-RED flow

Now join your Button node output to the existing
Debug and LED nodes. Deploy the flow and test it by
pressing the button.
You will notice that the LED is lit to start with,
and that pressing the button switches it off. That’s
not quite right! This is because we are using pullup,
so the button pin will be HIGH by default. HIGH
generates the message 1, and this turns the LED on.
When we press the button, we cause the pin to go
LOW, generating a 0 message which turns the LED
off. We need to reverse the values. We want the
LED to receive the message 0 by default, and the
message 1 when the button is pressed.

Fixing the button

Remove the connection you made between the
Button node and the LED node by clicking on the
line and pressing DELETE on the keyboard.
Add a Switch node. This can be found in the
Function section. This node is similar to the
if/elif/else constructs you may have seen in

Figure 8 The switch is needed to make sure the button
can be used properly
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Scratch or Python. You can configure it to have
multiple output paths (outlined in red in Figure 8),
depending on the value passed in. In this case,
we will set up the node so that if the property
msg.payload is equal to 1, the first path will be
followed. Click the small Add button at the bottom

Make sure you have wired
your LED to both ground and
GPIO 17 on your Raspberry Pi
to add a second path, and for this path select
otherwise in the drop-down menu. This path will
be followed if the input is anything other than 1.
Figure 8 shows how your screen should look. Click
Done when you have finished.
You should see your newly created Switch
node, with two dots on the right-hand side for
outputs. Note that the title If input is 1 is simply a
description of what the node does, and has no effect
on its function. Join up the GPIO input Button node
to the input (left-hand side) of the Switch node.
Now drag in a yellow Change node from the
Functions section, and double-click on it to
configure it. We will use this node to change the
message being sent. Remember: when we created
the Switch node, the first output was set to be
followed if the input message was 1. We will use
the Change node to change the message to 0.
Press Done, then draw a line from the first
output of the Switch node to the Change node.
Then connect the output of the Change node to
the LED node. Now add another Change node to set
the msg.payload to 1. Connect this node to output
2 of the Switch node, and then to the LED node
(see Figure 9).
This tells the flow that when the otherwise
branch is followed (i.e. the msg.payload is not
already 1), we would like to change it to 1. When
you are ready, deploy your flow, and then push the
physical button to confirm that it works properly.
October 2017
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Tutorial

WALKTHROUGH

The hydroponic food garden one
month after transplant: 100 pots
containing about 450 plants

KENT ELCHUK
A Raspberry Pi enthusiast, web
developer, and gardening author who
is likely to be tinkering with code or
working in the garden.
growlode.com

MONITOR A

HYDROPONIC
GARDEN
Set up a webcam with moisture sensors and remote access to ensure big yields

You’ll
Need
> Motion
magpi.cc/
2gVrlp2
>S
 oil moisture
sensor
magpi.cc/
2gX3lSN
> USB webcam
>R
 aspberry Pi 3
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he cost of food is rising. Why not use your Pi
to build a hydroponic garden? Eat better and
dodge those expensive food prices! Hydroponic
growing is efficient, healthy, and easy to maintain –
especially when you can build a system that allows you
to leave the garden, and monitor it remotely from an
internet connection, for under $50 (£38).
Growing pesticide-free, hydroponic, or organic
hydroponic produce has never been easier –
especially now that the Raspberry Pi is here to help.
A hydroponic garden might not be the first place you
would expect to find a single-board computer, but in
this project it provides essential video monitoring and
moisture detection.
The project also uses a Raspbian-compatible
plug-and-play webcam to provide the video, and
the Motion Linux tool to handle the monitoring.
To detect soil moisture, you can pick up a cheap
breakout board online. The sensor can be assembled
in minutes, with just a few connections that hook
up to three Raspberry Pi GPIO pins and a moisturedetecting probe.

T
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Moisture detection and video monitoring will
provide the information you need to take care of your
hydroponic garden, and you can be alerted to any
problems via your internet connection. A simple home
web server is all you need.

Visual monitoring

Nothing can replace visual monitoring of your
garden. Using your webcam, you can inspect your
crop from remote locations. First, you’ll need to
install Motion:

sudo apt install motion
The next step is to edit the /etc/motion/motion.conf
file. You will need to edit it in a text editor such as vim
or nano:

nano /etc/motion/motion.conf
Carefully make changes to the file to match the
following code. Until you make these changes, the
raspberrypi.org/magpi
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There are two lights on the sensor
board – one light will always be
on, and the other switches on
when water is detected

Tutorial

The orange wire connects the
sensor board to GPIO 17, the red
wire to ground, and the brown
wire to the power

The moisture probe’s
metal plates are inserted
into the plant pot

system won’t work. It is a good idea to back up the
original file before making any changes.

MOISTURE
DETECTION
The system
works best
at detecting
new water
saturation,
rather than
measuring
the ongoing
moisture
percentage
with precision.

daemon on
width 640
# Image height (pixels). Valid range:
Camera dependent, default: 288
height 480
framerate 5
ffmpeg_output_movies on
snapshot_interval 60
stream_localhost off
webcontrol_localhost off
And finally:

vi /etc/default/motion
start_motion_daemon=yes
Restart the Motion service with sudo service
motion restart. Always keep in mind that you can
use the update-rc.d command to ensure that a
program starts automatically after a fresh boot:

sudo update-rc.d motion enable
When Motion saves video or JPEG files, they are
stored in the /var/lib/motion folder. By default, the
raspberrypi.org/magpi

The sensor is hooked
up to the GPIO pins,
and the webcam to
one of the USB ports

WEBCAM
Check the Raspbian compatibility of any webcam
before purchase. You’ll find a list of Pi-compatible
webcams at magpi.cc/2gVs35G.

HYDROPONIC
FEEDING
INTERVALS
Use a timer
to run one,
two, or more
predictable
feeds per day.
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WALKTHROUGH

The Pi keeps an eye on the garden
and helps the author to check on it
from remote locations

REMOVE OLD
IMAGES
Remove JPEG
images from
the /var/lib/
motion folder
from time to
time to free up
disk space for
future images.

files are timestamped, and the most recent file is
always titled lastsnap.jpg, which makes the file system
easy to work with.
During a Motion installation, it is likely that
the folder where the files are saved will need new
permissions. To give that folder owner and group
permissions for Motion, type:

chown -R motion:motion

/var/lib/motion

At this stage, you should be able to access the
Raspberry Pi from a browser (http://local_pi_ip:8081)
and see the streaming webcam video – even after
a reboot.

Home web server
WIFI AUTOCONNECT
To work
effectively,
the Pi should
always use the
same network
IP address to
connect to
your WiFi.
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A home web server is the easiest way to access
the most up-to-date picture of the garden from
a remote location. It also allows you to interact
with the moisture sensor. To access your home
server, type the home IP address into your browser.
If you don’t know your IP address, you can find
it at iplocation.net.
It only takes a few commands to install a web
server and PHP, and make your Pi into a home server.
To keep this tutorial simple, the following commands
show how to install the Apache web server and PHP:

October 2017

sudo apt-get update
sudo apt-get install apache2
sudo apt-get install php7.0 php-pear
libapache2-mod-php7.0 php7.0-mysql
sudo apt-get install php7.0-curl php7.0json php7.0-cgi
With these packages installed, you should be able to
view the new website at your IP address via a browser
or with a free online proxy. Make sure your router
can forward port 80 to let you see the webpage, and
optionally port 8081 for live streaming.

Monitoring water

The soil moisture sensor is a common Pi add-on,
and hooking it up is easy. The moisture sensor board
connects to three GPIO pins on the Pi: GPIO 17, power,
and ground. The sensor board is also connected to the
metal plates of the moisture probe.
The unit works straight away – all you need to do is
stick the probes into a pot. If you see only one light
on the sensor board, add some water. After adding
water, you should see two lights. In our experience,
the moisture detection light illuminates after
watering, but the sensor board can go down to one
light within an hour, even though the soil or growing
medium has retained some moisture. You can use
raspberrypi.org/magpi
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MONITOR A HYDROPONIC GARDEN
this system to make sure a scheduled watering
has happened.
The script used in this project to detect moisture
uses PHP. PHP has a shell_exec() function that allows
the easy use of Linux shell commands instead of using
a GPIO library. Find the code in the code listing box.

Remote access

Let’s start tying everything together. We have a script
that detects watering, and lets us know if watering
is on or off. Watching this is very easy: just open the
page in a browser.
Since seeing is believing, viewing the lastsnap.jpg
file lets you see how the plants are doing at any time.
This image is saved to the Motion folder, and you can
set up a cron job (use crontab -e) to move this file to
the HTML folder and display it in the browser:

Language

index.txt

>PHP

<img src="http://local_ip_with_
motion_service:8081/" width="320"
height="240"/>

DOWNLOAD:

magpi.cc/2gVYroO

<img src="lastsnap.jpg" width="320" height="240"/>
<?php
$on_off = shell_exec('gpio read 0');
echo $on_off;
if($on_off == 1){
echo "<br/>It is off";

* * * * * cp /var/lib/motion/lastsnap.jpg
/var/www/html/test.jpg && chown pi:pi /var/
www/html/lastsnap.jpg

}else{

The resulting page shows the live stream, the most
recent image, and a message reporting the results
from the sensor. Save the URL to your phone and open
it at will. You can display your data as shown in this
tutorial, or just set up the parts you want to use.

}

echo "<br/>It is on!<br/>";

?>

Hydroponics basics

Although the focus of this article is about monitoring
the plants, it is helpful to know a little about vertical
hydroponics, which uses interlocking quad pots
stacked on top of each other.
When growing, tomatoes can be stacked two or
three pots high; lettuce, cucumbers, and peppers do
well with five or six pots stacked up. The stacking
gives very high yields per square foot.
To feed the plants, nutrients are delivered using a
pump that sends liquid nutrient through half-inch
polythene tubing. Along the half-inch header line,
barbed fittings are inserted so that quarter-inch
tubing can send fluid to each pot. Irrigation into the
pots takes place slowly, regulated by drippers inserted
into the ends of the pipes.
Plant stakes are used to hold the drippers in place.
At the very bottom of the system are individual
three‑gallon (11-litre) pots that catch the waste
nutrient. These bottom pots also hold plants.
In each pot, you can use a medium like soilless mix,
coco coir, peat/perlite mix, or even well-draining dirt.
As far as feeding is concerned, any hydroponic plant
fertilizer is fine – powders are often much cheaper
than liquid. A food-grade 55-gallon (208-litre) drum
makes a good, cheap, food-grade nutrient tank.
When you mix a nutrient solution, a pH pen and
EC/TDS (total dissolved solids) meter will help to
fine-tune the plant diet. You can cut costs by using
pH test strips or a liquid pH test solution. Normally,
raspberrypi.org/magpi

your water and mix pH values will be consistent, so
you shouldn't need to test them very often. A pH of
6.0‑6.5 works for most vegetables, while 1500‑1800
ppm (parts per million) TDS indicates a decent
fertilizer salt concentration. When growing lettuce,
a lower TDS value (400-500) may be sufficient.
Hydroponically grown produce can yield big
harvests and lots of growth, so be ready to supply
some support for your giant plants! On the other
hand, lettuce is easy to care for, and many varieties
of tomatoes will trail downwards without requiring
any support.
As well as producing plenty of pesticide-free food
all year around, a growing garden can bring enjoyment
and peace to your home.

Above The author
in his vertical
garden, which
requires less
than ten minutes
of maintenance
every day
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F.A.Q.

YOUR QUESTIONS ANSWERED

FREQUENTLY
ASKED QUESTIONS

NEED A
PROBLEM
SOLVED?
Email magpi@raspberrypi.org or
find us on raspberrypi.org/forums
to feature in a future issue.

Your technical hardware and software problems solved…
Image credit: CC-BY-SA-3.0: Victorgrigas

USING YOUR RASPBERRY PI

AS A SERVER
WHAT IS A SERVER?
Conventional server
Think of a server as a big computer that smaller
computers, such as your desktop or Raspberry Pi,
communicate with to get information. This could be
online, to open a website, or to download a file from
your favourite cloud service. They’re generally more
powerful, and have much more storage, than an
average PC.

Home server
A home server is a scaled-down version of an online
server. On a home network, where only a few devices
will be accessing it at any one time, you don’t need a
very powerful system to act as a server. In fact, most
home servers are less powerful than a desktop PC, and
it is common for people to use an old PC as a server.

Raspberry Pi server
A Raspberry Pi may not be powerful enough to use as
a conventional server, but it is perfect for use at home
or in a small office. Using a spare Pi to serve files and
media to your network can be a great and cheap way to
meet your file storage and sharing requirements.

HOW DO I BUILD A
RASPBERRY PI SERVER?
Storage
You’ll need to add extra storage to the Raspberry Pi
if you want to use it as a server. Depending on your
requirements, you could use a large USB flash drive or a
USB portable hard drive. The hard drive may be slower,
but it will allow for constant writing and rewriting.

Operating system
You’ll find plenty of tutorials demonstrating how
to set up a server using Raspbian, but there are
other operating systems for the Pi that offer server-
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specific tools. Arch (magpi.cc/2nf6YFk) and Fedora
(magpi.cc/2miaZUL) are highly customisable and
secure; Chromium OS (magpi.cc/2njuVeS) offers a
web kiosk setup; and PiBox (magpi.cc/2x4nutO) is
optimised for use as a media server.

Networking
The built-in wireless LAN on the Raspberry Pi 3 and
Pi Zero W is faster than a wired Ethernet connection.
A wired connection will be more stable, but may
involve trailing wires around your house. You’ll
need to decide what will work best for you.

WHAT ARE THE BENEFITS
OF A RASPBERRY PI SERVER?
Low power
The Raspberry Pi draws very little power, so you can
leave it running 24/7. Linux-based operating systems
are very stable, so a Raspberry Pi server is well equipped
to run for long periods of time.

Size
Even the largest Raspberry Pis are only the size of a
credit card, giving your Pi server a very small footprint.
The Pi Zero is even smaller, and some makers have
created home servers where the Zero is built into the
mains plug that powers it (magpi.cc/2y3dNLP).

Community
Want to set up your Raspberry Pi server? The Raspberry
Pi community is very active, and provides tutorials and
solutions for almost any problem, including specific
server setups. You may even find suggestions in the
forums that you hadn’t thought of, which will make
your computing life even easier.

raspberrypi.org/magpi

YOUR QUESTIONS ANSWERED

F.A.Q.

FROM THE RASPBERRY PI FAQ

RASPBERRYPI.ORG/HELP
WHY IS THERE NO REAL-TIME CLOCK (RTC)?
The expectation is that non-network-connected units will
have their clocks updated manually at startup. Adding an
RTC is surprisingly expensive once you have factored in
batteries, area, and components, and would have pushed
us above our target price. You can add one yourself using
the GPIO pins if you’d like an interesting electronics project.

CAN I ADD EXTRA MEMORY?
No. The RAM on the Model A, A+, B, B+, and Zero is a
Package on Package (PoP) on top of the SoC, so it is not
removable or swappable. The RAM on the Pi 2 and 3
Model B versions is on a separate chip on the bottom of
the PCB, but 1GB is the maximum RAM that the SoC used
by the Pi 2 and 3 Model B versions can support.

WHY DOESN’T THE RASPBERRY PI INCLUDE <INSERT
NAME> PIECE OF HARDWARE OR <INSERT NAME> SORT
OF PORT?
Our main aim is a charitable one: we are trying to build the
cheapest possible computer that provides a certain basic
level of functionality, and keeping the price low means
we’ve had to make hard decisions about what hardware
and interfaces to include.

WHAT IS ITS OPERATING TEMPERATURE?
The Raspberry Pi is built from commercial chips which are
qualified to different temperature ranges; the LAN9514
(LAN9512 on older models with two USB ports) is specified
by the manufacturers as being qualified from 0°C to 70°C,
while the SoC is qualified from -40°C to 85°C. You may well
find that the board will work outside those temperatures,
but we’re not qualifying the board itself to these extremes.

raspberrypi.org/magpi
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GOT A GAP IN THE DIARY?
FILL IT WITH AN AWESOME RASPBERRY PI PROJECT.
hat will you say when your
friends and colleagues ask
you what you did at the
weekend? Watched a film, went out
for lunch, or had a lie-in?
Give them a better answer: in this
project roundup we show you what
you can achieve in two days. You
could build a robot, upgrade your
family’s toys, or fashion a sparkling
bag. You could connect your fridge
to the Internet of Things, or hack a
stereo to play your theme song when
you walk into the room.
Many of the projects are familyfriendly, so younger makers can join
in. Let’s get started!

W
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MAKE A

SMART
FRIDGE
DO YOU NEED TO BUY MORE
BEER, OR IS SOMEONE AT HOME
STEALING YOURS?
LET YOUR FRIDGE TELL YOU,
USING A WEB DASHBOARD.

JAMIE BAILEY
Jamie is the CEO and
founder of Initial State. He
has 16 years of experience
in product development,
integrated circuit (IC)
design and testing,
embedded systems, and
software development.
magpi.cc/2xy028v

ere’s a cool project: a drinks
fridge that uses a scale
to work out how many
bottles are inside, a temperature
sensor to help you keep the beers
chilled, and another sensor to
detect when the door is opened.
The data can all be streamed to a
web‑based dashboard.
Jamie Bailey conceived the project
as a way to stop his house-sitting
19-year-old nephew from stealing
his beer. Now, if a bottle is removed
from the fridge, Jamie gets a text
message and can call his nephew
to warn him off before the bottle is
even opened.
“I decided early on that a
web-connected scale was going to
be an effective, non-intrusive way
to make my beer fridge ‘smart’,”
Jamie says. “I didn’t want to
drill any holes in my fridge or
worry about communicating with
electronics from inside a closed,
cold box. Finding a web-connected
scale was frustrating because there
really weren’t any products on the
market that I could use. Once I
figured out that I could hack a Wii
Balance Board to talk to a Pi, the
project was truly a go.”
The Balance Board sits
underneath the fridge and
connects to the Pi over Bluetooth.
By knowing the weight of the
fridge and the weight of a bottle,
Jamie’s Python code can work

H

out how many bottles are inside
the fridge.
Data is streamed to a dashboard
designed by Initial State, the
company Jamie founded, which
provides graphs and the ability to
trigger a text message alert.
“It was so cool to take something
that I already had and turn it into
a data collecting, peace-of-mind
appliance that no one else in the
world had,” Jamie says. “It has been
such an awesome conversation
piece when friends and family
come over.”
Visit the link for a detailed guide,
including the code to create your
own smart fridge. Cheers!

MAKE YOUR FRIDGE SMART
ADD THE SCALES

ADD THE SENSORS

STREAM DATA

You can’t pair the Balance Board with
the Pi permanently. Use a pencil as
a lever so you can press the sync
button, even with the fridge on top.

The magnetic contact door sensor
connects to the Pi through a
breadboard, with a 10 kΩ resistor.
The temperature sensor sits inside
the fridge, with the wires running
through the door seal.

You can stream data to an Initial
State dashboard in JSON format
or with URL parameters. Download
Jamie’s code to test your sensors
and set up your fridge.
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TALKIEPI

DO YOU WANT TO MAKE INTERNET-CONNECTED WALKIETALKIES FOR ALL THE FAMILY? THAT’S A BIG TEN-FOUR!

atching Netflix series
Stranger Things inspired
Daniel Chote to make some
“big ol’ 1980s walkie-talkies” for
his family. His children Eddie (6)
and Ollie (3) can use them to chat
to each other, and to their friends,
through an internet-based server.
The software core is Mumble,
an open-source voice chat system
designed for use by PC gamers.
There are clients for a range of
operating systems, so the TalkiePi,
as Daniel has named his project, is
compatible with many other apps
and devices. The software can be
used to connect groups of people
who can chat to each other, like
using channels on a traditional
walkie-talkie.
Daniel used a US Robotics USB
Speakerphone, which sells for less
than $12, as the heart of his device.
He removed its case and connected
its board to one of the Raspberry
Pi 3’s USB ports.
He wired up some simple
components to the Pi’s GPIO pins:

W

a push-button to use when talking,
and two status LEDs at the bottom
of the speaker. One is illuminated
when you’re connected to the
Mumble server, and the second
lights up when other people are in
the chat room. A third LED inside
the button lights up when the
TalkiePi is sending your audio.
Daniel designed a case to house
the device using Autodesk’s 3D CAD
software Fusion 360. The case was
printed using a Monoprice Select
Mini 3D printer.
For now, the device is
powered using a wall socket, but
possible enhancements include
portable power.
You can find Daniel’s code
and 3D-printable design files at
magpi.cc/2vKbHP3.
Daniel’s advice to other makers?
“Keep it simple – be creative,”
he says. “Don’t be afraid to learn
new programming languages, or
even something like Fusion 360
for CAD.”
Roger that!

DANIEL CHOTE
Daniel is a believer that
everyone can learn new
things. If something
interests you, there really
isn’t anything stopping
you from attempting to
do it yourself.
magpi.cc/2vsqMtx

MAKE YOUR OWN TALKIEPI
SOLDER THE LEDS

ADD THE SPEAKER AND MIC MAKE A CASE

Connect the push-button. Solder the
status LEDs to wires, and connect
those wires via 330 Ω resistors to
your GPIO pins. Daniel uses a GPIO
header connector.

Unscrew the speakerphone. Connect
a right-angled mini USB cable to the
Pi’s USB port. Use it to connect the
speakerphone’s circuit board to the
Raspberry Pi.

raspberrypi.org/magpi

You can 3D-print Daniel's design. If
you don't have a 3D printer, you can
make your own case from cardboard
or LEGO, or use the project
without a case.
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MAKE A

ROBOT
MAKE A ROBOT IN A WEEKEND,
WHETHER YOU’RE MAKING YOUR
FIRST OR ADDING TO YOUR ARMY

hen Mark Norwood saw a
£5 spider robot toy in Tiger,
he thought: “That would
make a great Raspberry Pi project for
someone! Hey, that someone could
be me!”
The toys scuttle forwards when the
power is on, but now Mark has joined

W

MARK NORWOOD
Mark Norwood is a teacher
working in Bedfordshire,
specialising in teaching
young people with behaviour
problems. In his spare time
he walks, he dreams, and is
a Cub Scout Leader.
magpi.cc/2vsnhDs

two of the toys together to create a
spider that can walk forwards and
backwards, under the control of a
Raspberry Pi. The robot, Mr Nancy,
uses the right legs from one toy and
the left legs from another, so they
can be controlled independently.
The robot is based on the
Raspberry Pi Zero W. Mark uses parts
from the CamJam EduKit 3, which
provides everything you need to
make a simple robot – in particular
the motor controller board which
enables the Pi to control the motors.
The Raspberry Pi is powered using a
power pack from Poundland, while
four AA batteries drive the legs.
For the software, Mark used
a combination of Scratch for
line-following, and Python for
the distance sensor and obstacle
avoidance. He uses RealVNC on

his Chromebook to view the user
interface running on the Pi Zero.
This is Mark’s second robot based
on the CamJam EduKit 3, following
his Robocroc which motorised a
plastic shoe. “The kit is cheap, and
has everything you need, with good
instructions on the CamJam site,”
he says. “Everyone in the community
knows it, so they can give you help if
you need it.”
He found the GPIO Zero examples
on the Raspberry Pi website helpful,
and his advice to others building
robots is to “dabble with GPIO Zero,
because it massively reduces the
amount of coding you have to do.”
Mark’s website includes a
detailed photo essay showing the
construction of Mr Nancy, and you
can find out more about the CamJam
kit at magpi.cc/2xxPy8X.

BUILD YOUR OWN ROBOT
CHOOSE YOUR CHASSIS

ADD THE MOTOR BOARD

ADD ADDITIONAL SENSORS

Mark used two of these spider toys
for Mr Nancy, but you could build a
robot using a pencil case, a cereal
box, or a LEGO design.

The motor controller board from the
CamJam kit sits on your Pi’s GPIO
pins. Wire your motors into the left
and right terminal blocks, and your
motor battery to the middle block.

This distance sensor comes from the CamJam kit, and a
line-following sensor is also included. Use the CamJam
software to test them and add them to your robot.
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TRIGGER YOUR THEME SONG

WITH

DOORJAM

MAKE YOUR FIRST IMPRESSION COUNT BY TRIGGERING
YOUR THEME SONG AS YOU ENTER THE ROOM
s you walk through the
door, the bass starts
pumping and all heads turn
to look. You’re here, so it’s time to
get the party started!
You’re using Doorjam, which
triggers your theme song as you
enter the room. It works like this:
a Raspberry Pi 2 emits a Bluetooth
Low Energy iBeacon signal, which
can be detected by an iPhone. The

A

Bleno Node package enables a USB
Bluetooth dongle to act as an iBeacon.
On the phone, an app detects
the iBeacon and sends a signal to
a control server containing the
Spotify ID of the user’s song, and
the ID of the iBeacon that has been
found. The server uses Node.js to
push a command to the Pi to tell it
to play the music. Having the server
means that you can use the setup
to coordinate a whole network
of iBeacons across your building
or town.
“Bluetooth beacon ranging is
noxiously jumpy,” says Matt Reed,
who made the project. “An app may
think you’re between three and
ten metres away from a beacon at
any given second. The Bluetooth
received signal strength indicator
(RSSI) value is affected by obstacles
and other radio interference. I
overcame this by using an easing

MATT
REED
Matt Reed
is a creative

technologist at
agency redpepper.
magpi.cc/2wisSL6
equation to smooth the distance
proximation to the beacon. This
slows down the detection but makes
it more accurate, because you’re not
out in the parking lot while your
theme song is playing inside.”
This weekend project is best
suited to those with some Node.js
experience, but Matt’s blog includes
essential code snippets for the Pi
and the phone.
What is Matt’s choice of tune?
“I’m on a Boat by Lonely Island
Boys,” he says. “Don’t ask me why,
I just love that song and it makes
me laugh every time.”
What will your tune be?

MAKE YOUR OWN DOORJAM
CONNECT THE PI

CONNECT BLUETOOTH AND WIFI

The Pi’s audio out goes to the
boombox’s audio in. A power supply
(left) and 4G hotspot (right) on the top
enable the unit to work anywhere.

Matt used a Raspberry Pi 2 because he had one handy, so
he added dongles for wireless and Bluetooth connectivity.
You might prefer to simplify the project by using a Pi 3 with
wireless and Bluetooth connectivity built in.

raspberrypi.org/magpi

MAKE YOUR
TRIGGER
The app (built
using PhoneGap)
enables users to
look up the ID
of their Spotify
song, and tracks
the distance to
the iBeacon
when it is
detected. At
less than 10 ft
(3 m), it cues
the music.
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WEEKEND PROJECTS
MORE IDEAS TO ROUND OFF YOUR WEEKEND IN STYLE
PIX-E GIF CAMERA
Nick Brewer and his wife Shayna designed a Pi
Zero camera for recording animated GIFs. The
power comes from a LiPo battery connected to a
PowerBoost 500C to boost its output to 5 V. A button
connected to the GPIO is used to trigger the photo,
and an LED lights up while the GIF is being recorded.
The camera has a 3D-printed case design, and
printable paper wrap-arounds to make it feel like
a disposable film camera.
magpi.cc/2vuEBaK

PI TOTE
Amanda Haughs designed a tote bag with a Pi Zero
concealed in a pocket. It controls seven 5 mm clear
white LEDs in the embroidered Raspberry Pi logo,
which light up in a random order. 8-inch female-tofemale jumper cables are used to connect the LEDs
to the Pi and resistors. Amanda used GPIO Zero to
pulse the lights, and a cell battery for power. The
rc.local file was edited so that the program runs
when the Pi boots.
magpi.cc/2vrVIKB
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MICRO:BIT-CONTROLLED RADIO
Giles Booth made a radio
controlled by a BBC micro:bit,
using the buttons to change
stations and the tilt control for
volume. The micro:bit also displays
the station number. Giles used
David Whale’s bitio Python library

to access the micro:bit from the Pi,
and mpc and mpd to configure and
stream the stations. The os library
is used to send MPC instructions to
the command line. See Giles’s blog
for instructions, code, and a video.
magpi.cc/2xNc39m

LEGO BOAT
Ten-year-old Ozzy Hayler made a Pi-driven
LEGO boat, using a balloon for buoyancy.
The Pi Zero uses the Explorer pHAT as a
motor controller, and it drives a micro metal
gearmotor. Power comes from a LiPo battery
and LiPo shim. The remote pins function of the
GPIO Zero library is used to control the Pi from a
laptop. “Keep the motor and Pi dry,” he advises.
“I tested it in a bowl of shallow water first.”
magpi.cc/2grYg4l

THE SMART PHONE
Simon Jackson put the Google
AIY Projects Voice Kit into a
Fisher-Price telephone, creating
a more interactive toy for his
six-year-old son Owen. The
biggest challenge was getting
all the components to fit into

the housing. “I had to source a
smaller speaker to save on space.
Then the only way I could get the
Pi to fit was to cut the rear wheel
arches with a soldering iron hot
knife tip,” he says.
magpi.cc/2es19Sj

ARCADE MACHINE
With Lakka and Recalbox in NOOBS, and RetroPie readily
available, there are lots of software options if you want
to play the games you grew up with. There are several
controller options, too: Pimoroni’s Picade supports
joysticks and arcade buttons, and The Pi Hut makes a
SNES-style gamepad. Nate Douglas made this arcade
cabinet based on RetroPie using a Pi 3, half-inch
medium density fibreboard (MDF), a Samsung
22-inch LED monitor, speakers, and a keyboard.
magpi.cc/2vuCZhc
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MEARM PI

Maker
Says
An easyto-build robot
arm kit that's
designed to
get children
learning
about
technology,
engineering,
and
programming
Mime Industries

MEARM PI
This fun robot arm will grab the interest of children and adults alike
ong-time readers of
The MagPi may recall that
we reviewed the original
MeArm back in issue 33. While we
loved the concept of an affordable,
open-source robot arm, we did
note that a missing piece of the

L

Related
MAPLIN
ROBOTIC
ARM
Connected via
a USB port,
this robot
arm can be
controlled from
a Raspberry
Pi using the
PyUSB module
in Python.

£55 / $73
magpi.cc/2dLweuN
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puzzle was the need for users find
their own way to drive the servos
from a Raspberry Pi. The new
MeArm Pi solves the problem by
including a HAT with twin onboard joysticks, so now you have
everything you need in one kit.
Below The joystick controls
are on a HAT that slots easily
onto the Raspberry Pi

Not only that, but the arm
itself has been completely
redesigned, eliminating twothirds of the screws and using
new fixings to make it easier
to build. It certainly is a lot of
fun to put together, like a cool
motorised Meccano set. Step-bystep illustrated instructions are
supplied online – two versions,
for a standard-size Pi or a Pi Zero.
Most of the acrylic pieces simply
slot together, secured by a few
rubber bands, while three lengths
of screws are used for the moving
joints. A hex key is supplied for
this purpose, but you need to
avoid overtightening the screws
so that the joints can move freely.
The design is well thought out,
with strategically placed holes for
the servo cables to pass through
to keep them tidy. We found the
trickiest part was sliding the arm
raspberrypi.org/magpi
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MEARM PI
magpi.cc/2waqp7b

£70 / $95

into the base, which required
prising the two layers apart; we
also needed to loosen the base
servo horn slightly to enable it to
move freely.
The case that houses the
joysticks also features cut-outs
for the Pi’s ports, although
there’s no easy access to the SD
card, so you’ll need to download
and write the special OS image to
it before you enclose the Pi. Based
on Raspbian, the OS includes all
the required software and creates
a wireless access point so that you
can connect to and program the
MeArm Pi directly from a remote
computer or tablet. This means
it can be used headless, without
the need for a monitor, keyboard,
and mouse. There’s also the
option of connecting it to your
WiFi network if you prefer.

Twist your arm

Once the system has booted up,
which takes about 75 seconds
on a Pi 3, the arm jerks into life
and you can then control it using
the twin joysticks. This is a lot
of fun – like controlling a mini
digger, albeit with a claw. The left
stick handles base rotation and
lower arm movement, and the
raspberrypi.org/magpi

right stick controls the upper arm
and claw grip. While the servos
are pre-calibrated to be used out
of the box, we did encounter an
issue with the grip not closing
fully at first, but this was easily

functions (and sample code)
for moving the arm’s servos by
degrees for accurate control.
Naturally, you can set up loops
and conditionals to get the arm
to behave in sophisticated ways.

Most of the acrylic pieces
simply slot together, secured
by a few rubber bands
rectified by unscrewing and
repositioning the servo horn.
There is quite a lot of buzzing
from the servos, but we found the
control was accurate enough for
us to pick up small objects, such
as cherry tomatoes and socks.
A more interesting and
educational way to control the
arm is by programming it. While
you can do this directly on the
Pi, an easier way to get started
is by connecting a PC or tablet
to the MeArm Pi’s local web
server, by pointing a browser to
local.headlesspi.org. This gives
you access to four apps, each
for a different programming
language: Blockly, Snap!, Python,
and JavaScript. These include

There’s even the potential to
add a Camera Module to the end
of the arm (using an extra-long
ribbon cable) and use OpenCV
for image or face recognition to
control it – as demonstrated by
Mime (magpi.cc/2ffXB2J).

Last word
Despite a few teething troubles, we found the
MeArm Pi a joy to build and use. Manual control
using the joysticks is great fun, but programming
it is ultimately more rewarding. The headless
setup and local web server make it very easy to
get started, offering a choice of four programming
languages, although you could still opt to code it
directly on the Pi instead.
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WIRELESS USB GAME CONTROLLER
magpi.cc/2xpzdph

£14 / $18
Maker
Says
Perfect
for all your
Raspberry
Pi gaming
or robotics
needs
The PiHut

WIRELESS USB

GAME CONTROLLER
This versatile controller is easy to set up and great to use

he Raspberry Pi 3 is an
excellent base for retro
gaming projects. With
its speedy 1.2 GHz processor and
wireless networking, you can set
up a console in your front room
and bounce ROMs to it from
another computer.
Retro gaming consoles need a
controller – arcade games are little
fun to play with a keyboard and
mouse. And if you’re building a
retro games console, this Wireless
USB Game Controller is a great
companion device.
The style will be familiar to Sony
gamers. To our eyes, it’s based
on the PlayStation Dual Shock
from the PlayStation One days.
It features a D-pad, four buttons,
two analogue control sticks, and
four trigger buttons. In the middle
are Select, Start, Analog, and a
mysterious Turbo button.

T

Related
USB
GAMEPAD
(SNES-STYLE)
Not wireless,
but a classic
SNES-style
controller
that’s perfect
for recreating
classic gaming
moments.

£6 / $8
magpi.cc/2ve6iUo
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All of this is powered by three
AAA batteries, which we find
easier than charging up via a USB
cable. On the rear of the device
is an on/off switch that is used
to connect and disconnect from
the Raspberry Pi.
The feature we like most
is the 2.4 GHz Wireless USB
receiver dongle. Instead of going
through the awkward Bluetooth
pairing process, you plug in the
USB dongle, and it connects
straight away.
We tested it with RetroPie
and are pleased to report that it
worked first time without any
issues. As soon as we booted
into RetroPie, the Wireless USB
Game Controller appeared as
a device, enabling us to assign
buttons to controls. You will find
a RetroPie video installation guide
here: magpi.cc/2doUHrd.

During a game test, we found
the Wireless USB Game Controller
comfortable to hold and perfectly
fine to use. It’s not quite up there
with the original Dual Shock, but
it’s not far off, and better than
most third-party controllers.
You can also use the Wireless
USB Game Controller to control
robots – we looked at building a
Remote Control Robot in The MagPi
issue 51 (magpi.cc/Issue-51).

Last word
One of the best games
controllers we've found. Works
right out of the box and is a
comfortable, professional,
and slick piece of kit. A perfect
companion for retro gaming.
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MONKMAKESDUINO LCD KIT
magpi.cc/2x4P2ra

£25 / $33
Maker
Says
It will
provide you
with hours of
entertainment,
building
projects, and
learning how
to program
MonkMakes

MONKMAKESDUINO

LCD KIT

Have fun programming in a new way with the MonkMakesDuino LCD Kit
hile not specifically a
Raspberry Pi product
or project, the
MonkMakesDuino LCD Kit is a great
educational tool for coding, in a
similar vein to the MonkMakes Pi
kits that we’ve looked at in the past.
In fact, with our feature from issue
61 about using the Pi to interact
with Arduino, you can probably
connect the two together.
Unlike the Raspberry Pi, which
is a full computer, Arduino boards
like the MonkMakesDuino are
microcontrollers. You write code
on another computer, which you
then upload to the board for it to
run. This has various advantages
and disadvantages depending
on how you use the board (for
example, a microcontroller uses
less power, but isn’t as powerful).

W

Related
DISPLAY-OTRON HAT
A HAT for the Pi
with a three-line
LCD display that
is fun and easy
to program.

£22 / $28
magpi.cc/2y3DM5C
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For this kit, it’s just a different
way to learn about coding and
using electronics.
It’s called the LCD Kit, as the
main component it comes with is
just that: a simple LCD screen. It’s
not a full-colour display, but a twoline text display with 16 characters
on each line, allowing you to print
simple messages such as a live
temperature reading.
Being a MonkMakes kit, it also
comes with much more than the
board and LCD screen. Included
is a selection of LEDs, buttons,
sensors, and jumper wires, along
with a breadboard, so you can try out
different setups and projects. The
quality of the included projects is
fantastic, with easy-to-understand
tutorials on how to create cool
effects with the LEDs, and make

a countdown timer on the LCD.
There’s a great online repository of
code examples as well, so you don’t
have to type out everything by hand.
Thanks to the array of
components, this kit will definitely
be useful once you’ve finished with
the instruction book – buttons
and LCD screens are useful for
many projects.

Last word
A great kit that will teach you
another aspect of coding –
while also having lasting use
beyond the tutorials in the
book, thanks to its great array
of electronics components.

raspberrypi.org/magpi
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BOOKS

RASPBERRY PI
BESTSELLERS
ACTIVITIES FOR KIDS
As the nights draw in, Make will
entertain, educate, and upskill
your children.

WOODWORKING
FOR YOUNG MAKERS
Authors: L
 oyd Blankenship,
Lane Boyd
Publisher: O’Reilly
Price: £10.50
ISBN: 978-1680452815
magpi.cc/2vYnYzH

Teach your kids woodworking
skills with these well-chosen
projects: a wizard wand, a
sanding block, a charging
station, and a sturdy box with
a hidden compartment.

ELECTRICITY FOR
YOUNG MAKERS
Author: Marc de Vinck
Publisher: O’Reilly
Price: £10.50
ISBN: 978-1680452860
magpi.cc/2vYxGlP

A small collection of projects
using easy-to-obtain items
that combine fun, education,
and a reasonably good chance
of success – even for young
children with non-techy parents.

MAKE: PAPER INVENTIONS
Author: Kathy Ceceri
Publisher: O’Reilly
Price: £15.99
ISBN: 978-1457187520
magpi.cc/2vYomhI

Paper, switches, sensors.
Wearables from foldables.
Edibles. Generators and
geodesics. Space rovers and
sun spirals. Craft meets maths,
and next time you’re looking
to occupy bored kids, you’ll
bless Ceceri’s fertile mind.
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THINK PERL 6
Authors: L
 aurent Rosenfeld,
Allen Downey
Publisher: O’Reilly
Price: £47.99
ISBN: 978-1491980552
magpi.cc/2vYO6KH

Think Perl6 is aimed not
so much at teaching
Perl 6, but at teaching
programming (to ‘Think
Like a Computer Scientist’). Earlystage Python programmers will
benefit from seeing what they’ve
learnt re-examined in another
language, and with Perl 6’s ability
to work with modules written in
Python (and other languages),
Perl 6 may prove to be a good
second language.
The learning is split into
two sections – the first eleven
chapters covering the basics that
any programmer needs to know:
variables, expressions, statements,
functions, conditionals, recursion,

CNC MILLING
FOR MAKERS
Author: Christian Rattat
Publisher: Rocky Nook
Price: £22.50
ISBN: 978-1681983028
magpi.cc/2vYQNvI

Admit it: the thought
of owning your own
milling machine
is very tempting. Perhaps you
read the feature on Mark Buttle’s
Pi-controlled CNC machine in
The MagPi issue 39. The cost can
certainly be spread by clubbing
together and buying one for use
at your local makerspace. The
time involved in building one from
scratch is not insignificant, and
there’s a level of knowledge and
access to tools that not all spaces
will have. Given that, building
from a kit could be much more
viable, and Christian Rattat’s
book tackles this latter case.

operator precedence, loops, basic
data structures, and algorithms. The
second half covers more
advanced techniques and
paradigms that are still
essential, but perhaps
not needed day-to-day.
A great introductory
chapter covers topics like
debugging, abstraction,
and types. As we move
on to the assignment
of variables, Rosenfeld
does a grand job of beginning to
peel back the layers and starting to
glimpse the reasons for language
decisions, such as why variables
must be declared. It is this sort of
detail that also makes it a good book
on Perl 6 for those who can already
program in another language. There
are also more than a thousand
code examples, and good exercises
rounding off each chapter.

Score
More specifically, Rattat tackles
putting together the components
of a Stepcraft-2/600 which, with a
work area roughly the size
of an A2 sheet of paper,
and a range of attachments,
is pretty popular. Readers
considering a self-build, or
purchasing another design,
will still find plenty of
useful and detailed material
on general CNC machine
construction, design, and use.
Where this work loses
utility is the lack of Linuxspecific advice: Rattat only talks
about proprietary software,
and Stepcraft’s default USB
microcontroller offloads the
real-time control from the
operating system. Discussion
of the possible adaptations to
use LinuxCNC would have been
extremely useful here.

Score
raspberrypi.org/magpi
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OURS TO HACK

AND TO OWN
Editors: T
 rebor Scholtz,
Nathan Schneider
Publisher: OR Books
Price: £14
ISBN: 978-1682190623
magpi.cc/2vYdzUx

A ‘guidebook for a
fairer kind of internet’
that looks at emerging
platforms from a
cooperative standpoint. As Pi users
work on building the Internet
of Things, many are working to
build the platforms for working
together, and the infrastructure
for connected devices, such as
LoRaWAN networks across cities.
This is the open-source way.
The Silicon Valley way, by
contrast, is investment driven, and
needs to take control of the services
used – cloud infrastructure, learning
platforms, or online marketplaces
– and ‘extract value’. Ours to Hack

LEARN TO PROGRAM

USING
C++
ON THE RASPBERRY PI
Author: Phil Gardner
Publisher: Zero-Index
Price: £15.95
ISBN: 978-0995791800
magpi.cc/2vYR8yu

C++, like Java, does
not make a good first
language – at least
that’s the received
wisdom. The Pi encourages Python
and Scratch as beginner languages,
but it also comes with a complete
environment for compiling
programs written in C and C++,
and both of these languages
feature extensively in embedded
development. If building fun bits of
hardware with small boards is what
has attracted you to the Pi, then
why not dive straight in to C++?
Given the use of C-family
languages in some GCSE and
raspberrypi.org/magpi

and to Own is a wonderfully diverse
collection of short essays, offering
alternative visions for cooperation,
but backed by numerous
practical examples
of cooperativism in
action, such as the
Fairmondo online
marketplace, and various
funding platforms.
The writers are often
politically driven, and
it would be impossible
to agree with all of
them, but few essays fail
to raise interesting points for
consideration. And consider them
we must, as the kind of internet
to which we connect our hardware
projects and startup ideas is far
from settled, and will depend on the
voices and efforts of everyone who
wants an open platform on which
to build.

Score
A-level curricula, there is another
audience for a beginner-friendly
guide. Long-time coder and teacher
Phil Gardner gives us an examplerich, step-by-step guide,
written at a level for just
such new programmers.
It’s a large-format
book, which makes for
clearly legible screenshots
and code samples. All
the essentials of C++
are covered in an equally
matter-of-fact manner,
from conditionals and loops,
through arrays and functions,
to structs and pointers. Much
time is devoted early on to dealing
with errors, as this is the aspect of
programming most frustrating to
the newcomer. Little is Pi-specific,
beyond the ready-rolled compiler
environment, but this is an
excellent introductory text.

Score

ESSENTIAL READING:
INTELLIGENT PYTHON
We live in golden times, with everything
from essential algorithms to machine
learning accessible in Python.

Grokking Algorithms
Author: Aditya Bhargava
Publisher: Manning
Price: £27.99
ISBN: 978-1617292231
magpi.cc/2vYBgMw
A wonderfully visual guide to the
algorithms most programmers need,
backed up with simple Python snippets.

Make Your Own Neural Network
Author: Tariq Rashid
Publisher: CreateSpace
Price: £35.00
ISBN: 978-1530826605
magpi.cc/2vYNyEF
Rashid gives you a layman’s
guide to neural nets (some maths
involved), then clear step-by-step
Jupyter and Pi implementations.

Algorithms of the Intelligent Web
Authors: D
 ouglas McIlwraith,
Haralambos Marmanis,
Dmitry Babenko
Publisher: Manning
Price: £27.99
ISBN: 978-1617292583
magpi.cc/2vZc9cA
ML for web data with Python’s scikitlearn, in an algorithmic guide to
real-world data science problems.

Thoughtful Machine
Learning with Python
Author: Matthew Kirk
Publisher: O’Reilly
Price: £34.50
ISBN: 978-1491924136
magpi.cc/2vY3VS4
A terser ML guide, with more
maths and Python, but still a
fun and rewarding read.

Beyond Zero and One: Machines,
Psychedelics, and Consciousness
Author: Andrew Smart
Publisher: OR Books
Price: £14.40
ISBN: 978-1682190067
magpi.cc/2vYAPSv
AI is missing the point, unless robots
can learn to hallucinate like humans.
A fascinating and convincingly
argued look at consciousness.
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INTERVIEW

Szymon
Dzwonczyk
Occupation: CEO, Kell Ideas Ltd

TURTLE ROVER

INTERVIEW
We talk to the Mars Rover prototype engineers behind
the new Kickstarter rover, powered by Raspberry Pi
reated by the Mars Rover
prototype engineers at
Wroclaw University of
Technology, Poland, the Turtle is a
robust, waterproof rover that can
be used to explore hidden worlds
too small or dangerous for humans.

C

Can you tell us about
the Turtle Rover?
Turtle is an open-source mobile
robot designed to take every maker
payload in a new environment.
The rover is equipped with a full
HD camera, watertight case, and
a robotic arm. As it’s built around
a Raspberry Pi with Raspbian on
board, you can control it up to
200 m away by WiFi with any webenabled device (such as tablet,
laptop or phone).
Turtle can be used as a land
drone for cave and urban
exploration, as a development
platform for navigation and
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autonomy algorithms, and
even for business, as a robot
carrying special 3D-scanning
or inspection equipment.
Who is on the team?
We are a team of five who met at
Wroclaw University of Technology
in Poland. Julia is a creative director
and a graphic designer. She was
responsible for the rover interface

– essentially everything the
operator can see. Justyna is our PR
and marketing manager, showing
the world every detail of our work.
Aleksander is the mechanical
designer of the robotic arm and
other external equipment. Marcin
is our software and electronics
engineer, and made everything
to bring life to the rover. I am the
team head and chief mechanical

It’s easy to control from any internet-connected device

raspberrypi.org/magpi
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TURTLE ROVER INTERVIEW

The Turtle Rover goes with
you on your adventures

engineer. I built not only the Turtle
chassis, but the team as well.
How did the idea come about?
We’ve been involved in Mars rover
prototype development since 2015 at
Wroclaw University of Technology.
Then part of our team worked on
equipment for the joint ESA/DLR/
SSC BEXUS 21 mission that took our
environmental study experiment up
to the stratosphere. After working
for science, we decided to establish
our own company and use our
experience to design a ‘Mars rover’
for everyday users. From the start, it
was supposed to be extremely sturdy
yet affordable, to show everyone
that robotics doesn’t need to be
expensive to be useful.
Why the Raspberry Pi?
We used the Pi in the university
Mars rover design as well, and
Turtle is designed to fit a Raspberry
Pi 3. We are not only looking for
hardware when designing the
robots – the community is what

interests us the most. The rover
itself provides infinite possibilities,
but it’s the people who need to tell
you how to write image processing
code or give the rover the brain to
drive by itself. It’s a lot easier to
talk to someone else when working
on a project rather than keeping
everything to yourself.
As a team, we always loved
the idea of an affordable minicomputer to fit into our work,
and here we are.
How waterproof is it? Can you
explore underwater with it?
The rover is watertight, which
essentially means it can be
submerged underwater, up to three
metres deep. Every motor is sealed
using rubber components, and
both the boards and the battery
are enclosed inside watertight
cases. What’s more, there’s even a
special compartment to be utilised
by the user. You can add your own
electronics to the rover and still
keep it watertight.

The only thing with underwater
use is to remember to keep the
antenna above the water line.
Almost every wireless signal cannot
go through water. Using the rover’s
modular design, you can adapt one
of its cases to act as a buoy to keep
the antenna up – we plan to cover it
in our blog.

Above The rover
can explore
awesome places
with you

How long have you been
working on it?
With a five-year know-how
covering similar mobile robots,
we started to work on Turtle at the
beginning of June 2016. It was a
year-round struggle to keep the
rover functional, and to be able to
produce it using mostly our internal
resources. We don’t outsource the
assembly, and we produce most of
the components using 3D printing,
CNC machining, and laser cutting.
This is why we are so eager to
get as much feedback from both
our customers and open-source
DIY builders as possible. As the
production is super-elastic, we can
provide swift modifications to the
design to fit everyone’s needs.

GET INVOLVED!

Turtle Rover is watertight,
so it can go almost anywhere

raspberrypi.org/magpi

The Turtle Rover’s Kickstarter campaign ended a
few days after we went to print, but that doesn’t
mean you’ve missed out! The Turtle Rover is
completely open-source, including the files for the
3D-printed chassis. You can print, build, and code
one yourself, or buy a kit or an assembled robot
from turtlerover.com.
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THE MONTH IN
RASPBERRY PI
Everything else that happened this month in the world of Raspberry Pi

THE COMMUNITY’S
WEEKEND PROJECTS
Need more inspiration for your weekend projects?
Check out some of these cool projects from our readers
onday is not everyone’s
favourite day of the week.
However, we like to try to
add a little fun to your morning with
our weekend project roundup on
Twitter. Loads of readers send us the
stuff they’ve been working on over
the weekend, and we love to see it
all! Here are some of our favourites.

M
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FRED-209
A custom Nerf-firing robo-tank
that gives you only 20 seconds to
comply. We got a bit of a preview
of this last month, and we’ve been
excited to see the final product.
Learn more about it (and see it in
action!) here: magpi.cc/2xdabaQ.

OutRun Tomy toy conversion

Hologram

Steering wheel

While we’ve seen many console and arcade hacks
over the past few years, this inventive hack of one
of those sports car dashboard kids’ toys wowed us
when we saw it. It doesn’t hurt that it’s themed
around OutRun, one of the best arcade series of all
time. Find out more here: magpi.cc/2xckwUo.

A nice, simple project using an
engraved acrylic sheet and an LED
strip. Brian Corteil has managed
to make a very lovely hologrameffect light, and we want one
on our desk.

Not just a simple steering wheel –
this project is a custom controller
for American Truck Simulator.
Spencer Organ has been making lots
of different custom pieces for his
own special control setup.
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EMERGENCY TRANSMISSION:

PIONEERS
AUTUMN 2017 CHALLENGE
It’s a calamity of epic proportions, and only you can
save us! Time to get your thinking hats on, as you
use tech to #MakeYourIdeas and save us all!
e’ve received an alarming video message –
you can watch it at rpf.io/pioneers. We don’t
know this young woman’s name or exactly
what has happened, but we must help her! If things
are as bad as she says they are, our only hope of
survival is to work together.

W

Steps to saving the world
Bring together a TEAM of up to five awesome thinkers
and makers between the ages of 11 and 16, based
in the UK or the Republic of Ireland, together with a
mentor aged 18 or over.
REGISTER your team at rpf.io/pioneers.
Brainstorm something to help avert the crisis using
TECH, and then #MakeYourIdeas by Friday 1 December
– or else it will be too late.
Get cool stuff, WIN prizes, and save the world!

SURVIVAL PROJECTS

Your team needs to build something to help this
survivor in the treacherous situation she’s in. What
you decide to make is completely up to you – it
could be something to help you reach her location,
something to help monitor supplies, a way to warn
of approaching danger, or anything else you think
would help.
Any tech will do. This is an emergency, so you’ll
need to think creatively with anything you can get
your hands on: laptops, cameras, microcontrollers,
Raspberry Pis – anything at all. You can’t afford
to be choosy, so you’ll have to be resourceful with
whatever digital tech you have access to.
You need to make sure you record your working
process. Take photos and footage to document how
you build your make, and put together a video to
present your work when you’re done
making. That way, even if things don’t
work out quite as you’d hope, you’ll still
If you’re not quite ready
be able to show the work you put in – and
to
take part in this Pioneers
we’ll still want to see it. Even the wonkiest
challenge, head over
prototype can be a step on the road to the
to
rpf.io/pioneers
and click
tech that saves the world from disaster.
‘Get involved’ to register your
interest in future digital
making challenges.

Map out the zombies in the area.
Stay safe!

magpi.cc/2y9MCiq

Distract zombies by creating
classic literature

magpi.cc/2y9grQ3

Create an app for your phone
to avoid the zombies
magpi.cc/2y9xdOP
you mapped
raspberrypi.org/magpi
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FEATURE

HELP RASPBERRY PI

CELEBRATE ITS

BIRTHDAY!
The Raspberry Pi Foundation wants to put on a global celebration
for its sixth birthday – here’s how you can help!
or the last few years, we have held a big
Raspberry Pi community event in Cambridge
around Raspberry Pi’s birthday, where
people have come together for a huge party with
talks, workshops, and more. We want more people
to have the chance to join in with our birthday
celebrations next year, so we’re going to be
coordinating Raspberry Jams all over the world
to take place over the Raspberry Jam Big Birthday
Weekend, 3–4 March 2018.

F

Big birthday fun

Whether you’ve run a Raspberry Jam before, or
you’d like to start a new Jam in your area, we
invite you to join us for our Big Birthday Weekend,
wherever you are in the world. This event will be a
community-led, synchronised, global mega-Jam
in celebration of our sixth birthday and the digital
making community! Members of the Raspberry Pi
Foundation team will be attending Jams far and wide
to celebrate with you during the weekend.
Jams across the world will receive a special digital
pack, and we’ll also be sending out party kits to
registered Jams.
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Get involved

If you’re keen to start a new Jam, there’s no need to
wait until March – why not get up and running now?
Then you’ll be an expert by the time the Raspberry
Jam Big Birthday Weekend comes around. Visit
rpf.io/jam for more information, and submit your
event to the map when you’re ready.
Once your Jam is up and running, register it for
the birthday party: rpf.io/bdayjamform.
If you don’t fancy organising a Jam for our Big
Birthday Weekend, but would like to celebrate
with us, keep an eye on our website for an update
early next year. We’ll publish a full list of Jams
participating in the festivities so you can find one
near you.

NEED HELP
STARTING A JAM?
First of all, check out the Raspberry Jam page
to read all about Jams, and take a look at our
recent blog post explaining the support that we
offer: rpf.io/jam.
If there’s no Jam near you yet, the Raspberry Jam
Big Birthday Weekend is the perfect opportunity to
start one yourself! If you’d like some help getting
your Jam off the ground, we’ve produced a free
Raspberry Jam Guidebook full of advice gathered
from the amazing people who run Jams in the UK.
Download it from magpi.cc/2q9DHfQ.
If you have more queries, email
jam@raspberrypi.org.

raspberrypi.org/magpi

THIS MONTH IN PI

Community

KICKSTART THIS!
Raspberry Pi projects you can crowdfund this month

AUTOPI
kck.st/2wqOTGe

“What if your car had eyes?” the AutoPi Kickstarter
video asks. It’s a car computer powered by Raspberry
Pi that offers many enhancements over some of the
standard tech you find in modern cars. This includes
monitoring of your car’s performance that you can
check online at any time, customisable if-this-thenthat events, and dash cams.

NOTAGRAMA
kck.st/2wnR3F1

A pretty cool product that uses machine vision
and a Pi to read sheet music. You can lay out
music using chips or cards of specific notes on
the provided sheet, and it will read and play the
music. It looks like a fun way to learn how sheet
music works and experiment with how melodies
come together.

BEST OF THE REST
Here are some other great things we saw this month

PEDAL-PI

magpi.cc/2yaVwvN

This is cool: a Pi-Zero-powered
guitar effects pedal that can be
programmed to create different
effects and sounds when you
press it. It uses an extra board
to handle the inputs, but a lot of
processing is done on the Pi itself.

PIXELBERRY PI
Not a physical project, but a
wonderful pixel-art version of
the Raspberry Pi by Retronator!
When we first saw it in a Twitter
thumbnail we thought it was a
photo, which goes to show the
quality of this work.

raspberrypi.org/magpi

magpi.cc/2yaXOvg

magpi.cc/2ybcTgf

AUTOMATED NERF
SENTRY GUN
Nerf turrets are fun, but this one goes a step further by
adding facial recognition. It’s powered by IoT platform
n.io, and uses a Pi and laptop to look for targets by
detecting faces. When a target is found, the Pi points
the gun to aim at the target’s body. It looks to have a
beefy dart capacity, so unless you’re Wonder Woman
in no-man’s-land, you’d best stay out of its view.
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EVENT REPORT

MOONHACK 2017:
A NEW WORLD

RECORD!
Kelly Tagalan from Code Club Australia explains how kids
around the world hacked the moon to set a new world record

O

Below Children
coded a special
moon-themed
project using
Scratch, Scratch Jr,
or Python

88

n 15 August 2017, Code
Clubs around the globe
set a world record for the
largest number of kids coding in
a day! From Madrid to Manila and
from Sydney to Seoul, kids in Code
Clubs, homes, and community
centres around the world used
code in order to ‘hack the moon’.

October 2017

The Moonhack
movement

The first Moonhack took place in
Sydney in 2016, where Code Club
set a record of 10 207 kids coding
in a day.
The response to Moonhack –
not just in Australia but around the
world – blew the team away, and
this year they decided to make the
challenge as global as possible.
“I want to create anything that
can benefit the life of one person,
hundreds of people, or maybe even
thousands,” said one Code Club
Moonhack participant in Australia.
Preparation for the event
required a lot of teamwork and
collaboration within the global
Code Club family. The Code Club
New Zealand team helped to create
and execute new projects with help
from Code Club in the UK, while

Moonhack
2017
Date: 15 August 2017
Location: Worldwide

Code Club Canada, France, South
Korea, Bangladesh, and Croatia
all created translated materials to
allow even more kids to take part.

Moonhack 2017

From the moment the clock
struck midnight in New
Zealand, children had 24 hours
to try coding a specially made
Moonhack project using Python,
Scratch, or Scratch Jr. Creative
Moonhackers were encouraged
to make their own custom
projects, and there were amazing
submissions on a range of themes
– from moon football to heroic
dogs saving our natural satellite
from alien invaders!
raspberrypi.org/magpi
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MOONHACK 2017

Left Children from
56 countries took
part in the event

The top five Moonhack countries
submitting projects were
Australia, New Zealand, the USA,
the UK, and Croatia, but there
were contributions from so many
more amazing places, including
Syria and Guatemala. The event
was a truly international Code
Club collaboration!

Sydney to verify the record, and
we were thrilled to hear that we
came close to tripling the number
of kids who took part last year!

Global Moonhacking

The founder of Code Club
Bangladesh, Shajan Miah,
summed up the spirit of the day

Kids had fun taking part, and
experienced what it feels like
to create with code
In the end, 28 575 kids from
56 countries and 600 Code Clubs
took part in Moonhack to set
a new record. Record Setter
founder and Senior Adjudicator,
Corey Henderson, travelled to
Moonhack Mission Control in

well: “Moonhack was a great
opportunity for children in
Bangladesh to take part in a global
event. It connected the children
with like-minded people across
the world, and this motivated
them to want to continue learning

coding and programming. They
really enjoyed the challenge!”
Of course, the most important
thing about Moonhack was that
the kids had fun taking part, and
experienced what it feels like
to create with code. One astute
nine-year-old said: “What I
love about coding is that you can
create your own games. Coding is
becoming more important in the
work environment and I want to
understand it and write it.”
This is why we Moonhack: to
get kids excited about coding,
and to bring them into the global
Code Club community. We hope
that every Moonhacker who
isn’t yet part of a Code Club will
decide to join one soon, and
that their experience will help
guide them towards a future
involving digital making. Here’s
to Moonhack 2018!

FIND OUT
MORE

Kids got to work coding at Moonhack HQ

raspberrypi.org/magpi

If you would like to be part of Moonhack 2018,
make sure you sign up at moonhack.com for
alerts and news.
If you’re interested in volunteering at a Code
Club, head to codeclubworld.org to find out
more. There, you’ll find information on starting
a new club anywhere in the world.
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COMMUNITY
PROFILE

CAT
LAMIN

Certified Educator, Jam Maker, Teacher,
Outreach Champion and much, much more...

rom coding clubs to
educational events, pi-top
outreach and more, Cat
Lamin has become a regular face
within the Raspberry Pi community
– and for good reason.

F

Cat Lamin
Category: Raspberry Pi
Certified Educator

Day job: Education outreach
Website: twitter.com/CatLamin
catlamin.com

Below Ever the
avid ‘geek girl’,
Cat also dedicates
time to hacking
and digital making

Into the classroom

With a BA in English from the
University of Birmingham,
there was no question as to the
profession Cat saw herself working
in. “I’ve known I wanted to be a
primary school teacher since I was
about nine,” she admits, going
on to explain how her A-level
choices in Maths, Further Maths
and English helped to keep her on
track, completing her education
with a PGCE at the University
of Plymouth.

Cat went on to start teaching,
with her speciality in Maths, and
soon found herself lifted to the
role of Head of ICT. “One of the
children at my school told his mum
that ‘Miss Lamin makes being
geeky cool’, which was kinda cool,”
she reveals.
Moving on from teaching,
although she still dedicates a few
hours every fortnight to a local
school, Cat now works in the
computer science community,
offering her services across a
multitude of platforms and events.
“I get to teach in a school local to
me for an afternoon every other
week, so I’ve just been teaching Year
6 about interactive fiction, and can’t
wait to bring in some Raspberry Pis
for them to play with.”

From the age of nine, Cat has wanted to be an educator.
Through classes, educational talks, and coding events,
she’s reached more than the average classroom
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HIGHLIGHTS

PICADEMY

Championing education
For pi-top, creators of Raspberry
Pi-based learning tools, Cat
works as an Education Outreach
Champion, running workshops
and helping to grow the user
community. Through pi-top
she’s attended educational shows
such as Bett, given talks at the
Raspberry Pi Birthday Bash, and
presented to the Argentinian
Ministry of Education. “The other
thing I do at pi-top is talk to the
developers about their ideas for

Above As part of her role with pi-top, Cat
was recently sent to Argentina to talk to
the Ministry of Education

Evenings for teachers, offering
a relaxed introduction into the
world of computer science, and
co-hosting Wimbledon Jam with
Albert Hickey. “Occasionally,”
she adds, “I’ve been known to
organise something called a
#geekeat, which is just a meal in
central London or in Cambridge
where anyone who is part of the
Raspberry Pi community can meet

She’s continued to add to
her role by running Coding
Evenings for teachers
software, to try and help them
make it classroom-friendly,” Cat
explains. She then works to put
developers in touch with teachers
who may be able to offer help
and advice.
Outside pi-top, Cat also
dedicates her time to being an
active member of the Raspberry
Pi community. As a Picademy
alumnus, she’s facilitated two
further Picademy teacher training
events, with her third due later
this year. And if that’s not
enough, she’s continued to add
to her role by running Coding

raspberrypi.org/magpi

up with no pressure to do anything
other than talk and have fun.” So
when we say Cat is active within
the community, we mean it.
Cat will be attending PyCon
later this year to give a talk on
mental health, a subject she feels
strongly about, and hopes to help
raise awareness for developers
who suffer in silence. And moving
on, she’ll be joining fellow
Picademy alumnus and Raspberry
Pi Foundation Member Sway
Grantham in delivering advanced
Scratch training at the National
STEM Centre in December.

magpi.cc/2xbzGsZ

As well as being a Raspberry Pi Certified Educator (RCE),
Cat has helped to facilitate a few Picademy events, with
her third happening this October in Cardiff. Cat is one
of the many RCEs to agree that Picademy has had a
massive impact on her life.

MAPLE BEAR
CANADIAN SCHOOLS

magpi.cc/2xc2tO8

Having previously provided training aids for the
organisation, Cat was asked to visit Brazil for two weeks
this year to train teachers in computational thinking
at Maple Bear Canadian Schools in São Paulo, Belo
Horizonte, and João Pessoa.

HELLO WORLD

helloworld.cc

You’ll find Cat listed as a Featured Contributor in this
term’s Hello World magazine. While discussing teaching
coding to non-English-speaking students, she offers her
own solutions to the issues faced by educators.
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EVENTS

RASPBERRY JAM
EVENT CALENDAR

3

WEST-VLAAMSE CODERDOJO
RASPBERRY JAM
Roeselare, Belgium

Find out what community-organised, Raspberry Pithemed events are happening near you…

1

HUPIJAM

4

WESTSIDE
RASPBERRY JAM

Harrisburg,
PA, USA

Pearland, TX, USA

2

RASPBERRY PI
JAM ISTANBUL
Istanbul, Turkey

FIND OUT
ABOUT JAMS

8

Want a Raspberry Jam in

your area? Want to start one?

MELBOURNE PI
USER GROUP
Warranwood, VIC,
Australia

Email Ben Nuttall about it:

ben@raspberrypi.org

HIGHLIGHTED EVENTS
HUPIJAM

When: Saturday 7 October
Where: Harrisburg University,
Harrisburg, PA, USA
magpi.cc/2y7ghIW
A welcoming event where
you’ll meet and learn from
like-minded people in a
friendly environment.

RASPBERRY PI
JAM ISTANBUL

When: Saturday 7 October
Where: Büyük Milas Han,
Istanbul, Turkey
magpi.cc/2y7DElM
A Raspberry Jam for those in and
around Istanbul, which hopes to
become a regular event.
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REGULAR EVENTS
WEST-VLAAMSE CODERDOJO
RASPBERRY JAM

When: Saturday 21 October
Where: ARhus, Roeselare, Belgium

RASPBERRY JAM @ PI TOWERS
When: Saturday 7 October
Where: Raspberry Pi HQ,

magpi.cc/2x8pKAh
Together with CoderDojo, ARhus
is organising the very first
West-Vlaamse Raspberry Jam
in Roeselare.

Cambridge, UK
magpi.cc/2x8pWzB
A family-friendly event where all
are welcome, providing coding and
digital making activities for children
and adults.

WESTSIDE RASPBERRY JAM

CORNWALL TECH JAM

Pearland, TX, USA
magpi.cc/2x9C9nH
Come and show off your Pi
creations and learn each month
about a different component you
can use on the Pi.

Bodmin, UK
cornwalltechjam.uk
For anyone interested in
technology, of all ages and
abilities. Ask questions and
learn about programming.

When: Tuesday 24 October
Where: Pearland Westside Library,

When: Saturday 14 October
Where: Bodmin Library,

raspberrypi.org/magpi

EVENTS

Community

WE’VE HIGHLIGHTED SOME OF
THE AREAS IN NEED OF A JAM!
CAN YOU HELP OUT?

5

RASPBERRY JAM
@ PI TOWERS

7

16TH EGHAM
RASPBERRY JAM

6

CORNWALL TECH JAM

Cambridge, UK

Staines-upon-Thames, UK

Bodmin, UK

16TH EGHAM
RASPBERRY JAM

When: Sunday 15 October
Where: The Glanty,
Staines-upon-Thames, UK
magpi.cc/2x8qXaT
This month is Halloween themed,
so come along and make some
spooktacular Pi projects!

MELBOURNE PI USER GROUP
When: Tuesday 17 October
Where: Melbourne Rudolf Steiner

School, Warranwood,
VIC, Australia
mpug.clarkson.id.au
The group’s aim is to bring likeminded people together to talk about
how they’re using the Raspberry Pi.

raspberrypi.org/magpi

RASPBERRY JAM ADVICE

SAFETY

“Our venue, a university, required us to perform
a risk assessment and have public liability
insurance. I had experience with risk assessments
from work, so that was straightforward, but
anyone who doesn’t have that experience can
find plenty of examples online.”
Andrew Oakley
Cotswold Jam
Every Raspberry Jam is entitled to apply for a
Jam starter kit, which includes magazines, printed
worksheets, stickers, flyers and more. Download the
Raspberry Jam Guidebook at magpi.cc/2q9DHfQ.
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YOUR LETTERS

YOUR LETTERS
See my project

I have a fun Raspberry Pi project that I’ve made! How do I go
about showing it to you? Will I be able to put it in the magazine?

Alex D

We love seeing what you’ve made with the Raspberry Pi! Send us
your projects via email (magpi@raspberrypi.org) or on Twitter
(@TheMagP1). As for getting it into the magazine, it largely
depends on what you send us, but there are many ways for us to
feature cool projects in The MagPi.
Above The world’s thinnest Raspberry Pi 3. Image credit: Pimoroni

x86 Stretch

I upgraded my Raspberry Pi to the new version of
Raspbian Stretch and really liked it. I’ve managed
to misplace the disc with the PC version of the
Raspberry Pi Desktop, and I was wondering if the
version on there used Stretch or if it was still Jessie?
Either way, is there a place I can go to download
the ISO, as I’ve misplaced the disc? Thanks.

Sarah

The version of the Raspberry Pi Desktop for x86 PCs
that came with issue 60 was based on Debian Jessie
rather than Stretch, and has not been updated since
the release of Raspberry Pi Desktop on Raspbian
Stretch. We can point you to the ISO, as it’s available
now on the Raspberry Pi OS download page at
rpf.io/x86.
If you need a guide to installing it on your PC, we
have a new instructional video on how to do this,
which you can find at magpi.cc/2xbvyJG.

A minimalist Raspberry Pi

I’m aware you’re not able to get a kit to build a
Raspberry Pi; however, it would be quite useful
for me right now! I’d like to have something as
powerful as the Raspberry Pi 3 and as slim as the
Pi Zero, or even slimmer.
I was thinking about the Compute Module 3,
but I was wondering if there was a way to get a
bare Raspberry Pi 3 board? Is it safe to take apart a
commercial Raspberry Pi 3? I have a couple of spare
ones laying around.

Derek

Great timing with this question! Pimoroni has just
released a video on how to slim down a Raspberry Pi 3
by desoldering all the ports and pins except the micro
USB power port. You can find more information here:
magpi.cc/2xco4WD.
As for buying one, we don’t know of anywhere
that will sell you a plain board, so your best bet is to
follow Pimoroni’s instructions with one of your spare
Raspberry Pi 3s!

GETTING THE AIY
PROJECTS VOICE KIT
We’re still getting emails from a lot of people asking
how they can get their hands on issue 57 or the AIY
Projects Voice Kit that came with it. Well, the good
news is that Voice Kit is now available as a standalone
product! The Pi Hut is taking pre-orders for the kit in
the UK, and Micro Center in the US. Other retailers will
also be stocking it. See page 10 of this month’s News
section for more details.
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FROM THE FORUM: H

PRINTED
ESSENTIALS
The Raspberry Pi Forum is a hotbed
of conversations and problem-solving
for the community.
Join in via raspberrypi.org/forums

WRITE TO US
Have you got something you’d like to say?

Get in touch via magpi@raspberrypi.org or on The MagPi
section of the forum at: raspberrypi.org/forums

i, does anyone know when the
Camera Module Essentials book
is due out as a printed version?

Andrew

As we’ve done in the past, once we’ve
completed a new series of Essentials books,
we’ll do a print run and they’ll be available
in our store, and from Amazon and other
suppliers. We can’t say yet when that will
be, as even we don’t know quite yet. We
can assure you they’re coming, though.
If you can’t wait until then, you can
always print out a copy of the Camera
Module Guide using the PDF. As it’s licensed
under Creative Commons, we let you
do that – you could even go to a proper
printer and get a nice glossy version
for yourself! Grab the PDF from here:
magpi.cc/2ufdjnT.

raspberrypi.org/magpi
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Above The Camera
Module Guide covers
everything you need to
know to get started with
the Camera Module
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IN ASSOCIATION WITH:

GOPIGO3

ROBOT KITS
We’ve got two GoPiGo3 Beginner
Starter Kits up for grabs, thanks
to our friends at Dexter Industries
(dexterindustries.com).
The GoPiGo3 is one of the best robots
we’ve ever seen. It’s packed with advanced
features, including encoders that provide
precision movement. Two lucky winners will
get a maxed-out GoPiGo3 kit and accessories:
• GoPiGo3 Starter Kit
• Dexter OS microSD Card
• Temperature Humidity Pressure Sensor
• IMU Sensor
• Light & Colour Sensor
• Sensor Mount
• Dexter Labs T-Shirt

Learn more about
the GoPiGo3 at
magpi.cc/2udLQQ3

Enter now at magpi.cc/WinOct17
Terms & Conditions
Competition opens on 27 September and closes on 26 October. Prize is offered to participants world-wide aged 13 or over, except employees of the Raspberry
Pi Foundation, the prize supplier, their families or friends. Winners will be notified by email no more than 30 days after the competition closes. By entering the
competition, the winner consents to any publicity generated from the competition, in print and online. Participants agree to receive occasional newsletters from The
MagPi magazine. We don’t like spam: participants’ details will remain strictly confidential and won’t be shared with third parties. Prizes are non-negotiable and no
cash alternative will be offered. This promotion is in no way sponsored, endorsed or administered by, or associated with, Instagram or Facebook.

raspberrypi.org/magpi
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Column

THE FINAL WORD

MATT RICHARDSON
Matt Richardson is the Executive Director of the Raspberry
Pi Foundation North America and author of Getting Started
with Raspberry Pi. Contact him on Twitter @MattRichardson.

CREATING
TO LEARN
In Matt Richardson’s experience, creating projects leads
to the most efficient learning

was a graduate school student in New York
City in 2012 when the extremely destructive
hurricane Sandy made landfall on the North
Atlantic coast of the United States. Our student email
group was especially active at that time. Classes were
cancelled and students were checking in as safe,
reporting problems, and helping each other out. The
email threads told a story about what was going on at
the time, and so I wanted to capture and present that
story outside the context of email. I wanted to take the
story told by the emails and put it into my own singleedition physical book.

I

Python project

To accomplish that, I spent a full weekend figuring out
how to get Python to read emails from my account,
process them, and create a PDF to send to the printer for
publishing. It started off as a simple enough idea, but
the complexity began to reveal itself as I worked on the
project. How do I number the pages? How do I split up
the chapters? How do I create a table of contents? How
do I solve the problem of odd characters in the emails
that were wreaking havoc with my Python script?
During that weekend of figuring out how to turn email
messages into a printed book, I probably learned more
about Python than I have at any other time in my life.

Creative learning

Just a few days ago I was reminded of this experience
when I came across a great piece of advice on Twitter
from Seattle-based data scientist Jake VanderPlas
(@jakevdp). He tweeted, “My advice on learning
Python: Don’t set out to ‘learn Python’. Choose a
problem you’re interested in and learn to solve it
with Python.”
98
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Jake’s tweet perfectly sums up what I learnt firsthand while toiling away to create a physical volume
of hundreds of email messages. Having a particular
project in mind when you use any technology (and
not just Python) is the best way to learn it. Creating
something new provides a clear objective, and
you get more out than you put into it. You bring
something new into the world, and you learn a lot
along the way.

Real objectives

Having a clear objective for what you want to achieve
gives you more drive to learn. I believe that this is
one of the reasons why project-based learning is
such an effective methodology. You’re not learning
only for the sake of learning. Learning by creating
something gives you the opportunity to apply
what you learn, and gives you the determination
to get it done. There’s more satisfaction in creating
something you wanted to make than there is in
solving a hypothetical problem.
When you’re creating with technology, you’re
not only learning about that technology, but also
developing some of your soft skills. Rarely does
a project come to fruition without a little bit of a
struggle. Creating projects often takes patience,
persistence, and grit. These are characteristics that
you won’t learn in a textbook or from a lecture.
After a lot of persistence getting my Python script
just right, I sent the file to be printed as a bound
volume of emails. When I received it in the mail the
following week, I was so pleased with how the project
turned out. The source of much of that satisfaction
was how much I learnt in order to achieve that goal.
I didn’t just learn to create. I created to learn.
raspberrypi.org/magpi

Tutorial

ESSENTIALS

LEARN | CODE | MAKE

OUT NOW IN PRINT

ONLY £3.99
from

raspberrypi.org/magpi

ESSENTIALS
raspberrypi.org/magpi

From the makers of the
official Raspberry Pi magazine

GET THEM
DIGITALLY:
April 2016
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